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Preface

The Rational Suite Installation Guide provides you with the information that you need
to install Rational Suite for UNIX. Additional information about each point-product in
the Suite is provided in the point-product documentation, which is available on the
Rational Solutions for UNIX Online Documentation CD.

Rational Suite delivers a comprehensive set of integrated tools that embody software
engineering best practices and span the entire software development life cycle.
Rational Suite has an unparalleled level of integration that improves communication
both within teams and across team boundaries, reducing development time and
improving software quality.

Audience

This guide is intended for developers, system administrators, and quality engineers,
who use Rational Suite.

Other Resources

= All manuals are available online, either in HTML or PDF format. The online
manuals are on the Rational Suite DevelopmentStudio UNIX Online Documentation
CD.

To send feedback about documentation for Rational products, please send e-mail
to techpubs@rational.com.

= For more information about Rational Software technical publications, see:
http://www.rational.com/documentation.

For more information on training opportunities, see the Rational University Web
site: http://www.rational.com/university.
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Contacting Rational Technical Support

When you contact Rational Technical Support, please be prepared to supply the
following information:

= Your name, company hame, telephone number, and e-mail address

= Your operating system, version number, and any service packs or patches you

have applied

Product name and release number

Your case ID number (if you are following up on a previously reported problem)

= The Rational Account number listed on your Rational License Key Certificate
(Rational Licensing Technical Support only)

Contacting Rational Technical Support

If you have questions about installing, using, or maintaining this product, contact
Rational Technical Support as follows:

Your Location

Telephone

Facsimile

E-mail

North America

(800) 433-5444
(toll free)

(408) 863-4000
Cupertino, CA

(781) 676-2460
Lexington, MA

support@rational.com

Europe, Middle
East, Africa

+ 31 (0) 20-4546-202
Netherlands

+31 (0) 20-4545-201
Netherlands

support@europe.rational.com

Asia Pacific

+61-2-9419-0111
Australia

+61-2-9419-0123
Australia

support@apac.rational.com

Contacting Rational Licensing Technical Support

If you have questions about acquiring license keys for your Rational Software

products, contact Rational Licensing Support as follows:

Your Location

Telephone

Facsimile

E-mail

Asia Pacific +61-2-9419-0111 +61-2-9419-0123 license@apac.rational.com
Asia Pacific +61-2-9419-0111 +61-2-9419-0123 license@japan.rational.com
(Japan)

Contacting Rational Technical Support  xvii



Your Location

Telephone

Facsimile

E-mail

(Mainland China,
Hong Kong, and
Taiwan)

Asia Pacific +82-2-556-9420 +82-2-556-9426 license@apac.rational.com
(Korea)
Asia Pacific +61-2-9419-0111 +61-2-9419-0123 license@china.rational.com

Europe
Middle East
Africa

+31 20 4546 200

+31 20 4546 202

license@europe.rational.com

North American
(East Coast) South
America

800-433-5444
(toll free)

781-676-2460

license@rational.com

North America
(West Coast)
Central America

800-433-5444
(toll free, USA only)

+1 (408) 863-4000

408-863-4001

license@rational.com

Requesting Licenses

To request or return permanent (or Term License Agreement) license keys, access
AccountLink: http://www.rational.com/accountlink.

Receiving Important Product Announcements

xviii

To receive automatic notification of new releases, patches, and critical technical
information, subscribe to our announcements e-mail distribution list.

To subscribe:

1 Send an e-mail to majordomo@rational.com.

2 Inthe body of your message, type:

subscri be uni x-sui t e-announcenent s

To unsubscribe:

1 Send an e-mail to majordomo@rational.com.

2 Inthe body of your message, type:

unsubscri be uni x-suite-announcenents
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Overview

Rational Suite for UNIX is available in two editions:
Rational Suite DevelopmentStudio for UNIX
Rational Suite DevelopmentStudio RealTime for UNIX

Rational Suite DevelopmentStudio for UNIX is customized for software architects,
designers, and developers. These practitioners use Rational Suite to design, evaluate,
and implement software architecture and applications.

Rational Suite DevelopmentStudio RealTime for UNIX is our newest edition of
Rational Suite for UNIX. This edition of Rational Suite includes Rational Rose
RealTime, which is customized for developers who focus on real-time and embedded
software development. This Suite edition contains all the tools in Rational Suite
DevelopmentStudio, but replaces Rational Rose with Rational Rose Real Time.

Rational Suite also comes in several Windows-based editions. Each edition of the
Suite targets specific practitioners: analysts, developers, testers, project leaders, and
web teams. For more information about other Rational Suite editions, see the guide,
Rational Suite Introduction.

Note: Unless otherwise specified, all further references to Rational Suite, Rational
Suite DevelopmentStudio, or Rational Suite DevelopmentStudio RealTime, refer to
the UNIX-based Suites.

Products Included in Rational Suite

Table 1 summarizes the point products provided in each edition of Rational Suite.
Additional information about the point products is provided in the sections that
follow the table.
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Table 1 Point Products in Rational Suite for UNIX

DevelopmentStudio DevelopmentStudio
RealTime Edition

Point Products

Rational Unified Process . .
= . L 1 1
5 | Rational RequisitePro . .
5
C;, Rational ClearQuest o2 o2
=
%’ Rational SoDA . .
=}
€ | Rational o .
o | ClearCase LT
'_
Rational TestManager o3 o3
Rational Rose . o4
Rational PureCoverage . .
Rational Purify . .
Rational Quantify . .

[N

This is a Rational Suite Windows Component. UNIX user access is through their
browser using Rational RequisiteWeb.

This is included as both a Rational Suite UNIX Component and a Rational Suite
Windows Component. UNIX users can access Rational ClearQuest through a
native UNIX interface or through their browser using Rational ClearQuest Web.
Although shipped on its own CD, UNIX Test Agent software works in
conjunction with Rational TestManager. Access to a UNIX Test Agent is
available only through Rational TestManager, which is run from within the
Windows environment.

4 RealTime Edition

N

w

Rational Suite (UNIX Components)
Rational Suite (UNIX Components) includes the following point products:
Rational Unified Process
Rational ClearQuest
Rational SODA
Rational Rose or Rational Rose RealTime (depending on the Suite Edition)
Rational PureCoverage
Rational Purify

Rational Quantify
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Rational Test Agent (UNIX Test Agent)

Note: The group of products, Rational PureCoverage, Rational Purify, and Rational
Quantify are referred to collectively as Developer Tools in this guide.

Rational Suite (UNIX Components) is installed from the Rational Solutions for UNIX
CD and requires either a Rational Suite DevelopmentStudio (UNIX Components) or a
Rational Suite DevelopmentStudio RealTime (UNIX Components) license key.

The UNIX Test Agent is installed from the Rational Test Agent CD. UNIX Test Agent
software works in conjunction with Rational TestManager, which is run from within
the Windows environment. Your Rational Suite DevelopmentStudio (Windows
Components) or Rational Suite DevelopmentStudio RealTime (Windows
Components) license key is used to run Rational TestManager and Rational Test
Agent.

Rational Suite (Windows Components)

Rational Suite (Windows Components) includes the following point products:
Rational RequisitePro
Rational RequisiteWeb
Rational ClearQuest
Rational ClearQuest Web
Rational TestManager

Rational Suite (Windows Components) are installed from the Rational Solutions for
Windows CD and require either a Rational Suite DevelopmentStudio (Windows
Components) or a Rational Suite DevelopmentStudio RealTime (Windows
Components) license key.

Other Products

The following additional products are provided with Rational Suite:
Rational ClearCase LT
Rational Rose RealTime Companion Products
Crystal Reports
Rational License Server Software
Adobe Acrobat

Netscape Navigator

Products Included in Rational Suite 21



Rational ClearCase LT

Rational ClearCase LT is provided on a separate CD as an optional product for you to
install. You can use your Rational Suite DevelopmentStudio (UNIX Components) or

Rational Suite DevelopmentStudio RealTime (UNIX Components) license key to run

ClearCase LT.

To install this product, see the Rational ClearCase LT Installation Guide and Rational
ClearCase LT Release Notes.

Rational Rose RealTime Companion Products

The Rational Rose RealTime Companion Products are provided with Rational Suite
DevelopmentStudio RealTime. These products can be installed from the Rational Rose
RealTime Companion Products CD and include:

Rational Quality Architect
Rational Connexis

For licensing requirements for the Companion Products, refer to the Welcome Letter
included with the product. For more information about installing the Rational Rose
RealTime Companion Products, refer to the Rational Rose Real Time Professional Edition
Release Notes and Installation Guide.

Crystal Reports

Crystal Reports can be used with Rational TestManager or Rational ClearQuest
(Windows only) to customize or create new report formats from the standard output
generated by these two applications.

Crystal Reports is provided on the Crystal Reports Pro Edition CD. To install this
product, refer to instructions provided with the CD.

Rational License Server Software

This version of Rational Suite includes version 7.0f of the FLEXIm licensing server
software. It is highly recommended that you take advantage of the features provided
by version 7.0f to help optimize your license server’s performance.

The Rational License Server Software is provided on the Rational Solutions for UNIX
CD and on the Rational Solutions for Windows CD. For more information about
installing the Rational License Server software on UNIX, see Installing the Product on
page 55. For more information about installing the Rational License Server software
on Windows, see Installing the Rational License Server Software on Windows on page 97.
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Adobe Acrobat and Netscape Navigator

Adobe Acrobat 4.0 and Netscape Navigator 4.7 are provided on the Rational Solutions
for UNIX Online Documentation CD. For more information, see Online Documentation
on page 23.

Online Documentation

Rational Suite documentation is provided on the Rational Solutions for UNIX Online
Documentation CD. You can access the documentation directly from the CD or you can
install the documentation in the product installation area so that multiple users can
have access to this information. Generally, guides are provided in either HTML or
PDF format. In some cases, both formats (HTML and PDF) are provided.

If you prefer printed copies, the complete Rational Suite product documentation set
can be ordered separately. For more information, contact your Rational sales office.

Viewing Documentation Online

You can view all of the Rational Suite documentation both directly from the CD and
from the installed product area.

Prerequisites

A browser (for example, Netscape 4.7 or higher) is required to view HTML
documents. Adobe Acrobat is required to view the PDF files. Netscape Navigator 4.7
and Adobe Acrobat 4.0 are provided on the Rational Solutions for UNIX Online
Documentation CD for you to install.

Viewing Documentation from the CD

To view documents directly from the CD, run the command rs_help from the CD’s
root directory.

Viewing Documentation from the Installation Area
To view documents from the installed product area, run the command rsdsu_help

Note: You must set up your Suite environment for the shell that you are using by
running rs_setup.csh, or rs_setup.ksh, before you can use this command.

Online Documentation 23



Installation Guide Roadmap

Table 2 helps you to navigate through this guide.

Table 2

Installation Guide Roadmap

Chapter

Description

Before You Install

Provides information about the tasks you need to perform before
you install the software. Topics include hardware and software
requirements and planning your installation.

Understanding Rational
Suite Licensing

Provides information about license types and how to request a
license using AccountLink or using the fax request form.

Installing the Product

Provides instructions about how to install Rational Suite (UNIX
Components), Rational Suite (Windows Components), and the
online documentation.

Installing the Rational
License Server Software
on Windows

Provides instructions about how to set up a Windows server for
the Rational Suite (Windows Components).

Administering Licenses

Provides information about managing licenses.

After You Install

Provides information about configuring Rational Purify, Rational
PureCoverage, Rational Quantify, Rational Rose, and Rational
SoDA.

Troubleshooting

Provides information about troubleshooting your installation.

Overview of a Typical Installation

The following list gives an outline of what takes place during a “typical” installation.
Detailed instructions are provided in subsequent chapters.

Install the license server software and Rational Suite (UNIX components).

Test the licensing of the Rational Suite (UNIX components).

Configure the Rational Suite (UNIX components)

Check that the Windows host is correctly networked to the UNIX license server.

Install the Rational Suite (Windows components) on the Windows server.

Configure the Windows server to use the UNIX license server (if using a single
license server configuration).

Test the licensing of Rational Suite (Windows components).
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Configure the Rational RequisiteWeb and Rational ClearQuest Web interfaces (if
applicable) on the Windows system.

Test access to Rational RequisiteWeb and Rational ClearQuest Web (if applicable)
with a browser from UNIX.

To take full advantage of the Rational approach to software development, we
recommend that at least one person on your team (generally the analyst or product
manager) use a Windows system to author requirements with RequisitePro. These

requirements can be accessed on your UNIX workstation through the RequisiteWeb
interface.

Overview of a Typical Installation 25



26 Chapter 1 - Overview



Before You Install

The following topics are covered in this chapter:

= Before You Install Checklist on page 28

Rational Suite (UNIX Components) Installation Requirements on page 29

o

o

o

o

o

o

o

Hardware Requirements on page 29

Software Requirements on page 31

Installation Requirements for Rational Rose on page 32

Installation Requirements for Rational Rose RealTime on page 35

Installation Requirements Rational Rose Real Time Companion Products on page 35
Installation Requirements for Rational SoDA on page 35

Installation Requirements for Rational ClearCase LT on page 36

= Rational Suite (Windows Components) Installation Requirements on page 37

o

o

o

Installation Requirements for Rational TestManager on page 37
Installation Requirements for RequisitePro on page 37

Installation Requirements for RequisiteWeb on page 38

Planning Your Installation on page 40

Ensure that you meet the requirements listed in this chapter before proceeding with
the installation.
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Before You Install Checklist

Table 3 provides a checklist for tasks that need to be performed before you install
Rational Suite. Use this table as you run through steps to upgrade your Suite software

or perform a new installation.

Table 3

Before You Install Checklist

Step

Action

1 Verify that you meet the hardware and
software requirements for this release
of Rational Suite.

See the following sections:

= Rational Suite (UNIX Components) Installation
Requirements on page 29

= Rational Suite (Windows Components) Installation
Requirements on page 37

2 Determine how you want to set up
your server configuration based on the
products you are planning to use.

See Planning Your Installation on page 40

3 Backup your data. Backing up your
data prior to installing any new
software should be a regular practice.

This is especially important for
database products such as Rational
ClearQuest and Rational Requisite
Pro.

For ClearQuest, see the Rational ClearQuest
Installation Guide.

For Requisite Pro, see the Rational RequisitePro
Installation Guide.

4 Do you plan to install Rational
ClearCase?

Do you plan to install Rational
ClearCase LT?

If yes, install Rational ClearCase before you install
Rational Suite. Refer to the ClearCase product
documentation, located on the Rational Solutions
for Windows Online Documentation CD, for
instructions on how to install.

If yes, you should install Rational Suite
DevelopmentStudio first and ClearCase LT
second. See Installation Requirements for Rational
ClearCase LT on page 36.

5 Do you plan to use Rational SODA?

If yes, see Installation Requirements for Rational
SoDA on page 35.
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Table 3 Before You Install Checklist

Step Action

6 If you are installing Rational Suite If yes, you may want to install Apex before you
DevelopmentStudio, do you plan to install Rational Suite. Make a note of the Apex
use Rational Apex with Rational Rose | installation directory as you need to provide this
or with Rational SoDA? during the installation.

Alternatively, you can go ahead and install
Rational Suite and install Apex later. See
Integrating Products That Are Not Part of the Suite on
page 77 for information about how to integrate
Apex with Rose or SODA after you have installed
the Suite.

7 Obtain a valid license key. You need either a temporary license, an existing
license, or a permanent license before you install
the product.

If you are using an existing license, go to Step 8.

If you are using a temporary license, locate your
license key certificate and go to Step 8.

If you want to install the product using a
permanent license, see Requesting License Keys on
page 51.

8 You are ready to install Rational Suite. | See Installing the Product on page 55.

Rational Suite (UNIX Components) Installation Requirements

Hardware Requirements

Table 4 summarizes the hardware requirements for Rational Suite
DevelopmentStudio (Unix Components). Table 5 summarizes the hardware
requirements for Rational Suite DevelopmentStudio RealTime (Unix Components).
Note that the recommended amount of memory is only the suggested minimum
amount. Additional memory may improve performance. Your memory requirements
will also be larger depending on the tasks you are attempting and what else is
resident (running concurrently on the system). For example, the construction of larger
Rational Rose or Rational Rose RealTime models requires more memory.
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Table 4 Rational Suite DevelopmentStudio Hardware Requirements

Requirements

Product Swap Space | Memory Disk Space
Solaris HP-UX
Rational Unified NA 16 MB minimum 57 MB 57 MB
Process
Rose 150 MB + 64 MB + 335 MB +1to3 |365MB (10.20)
50 MB/user | 32 MB/simultaneous user | MB for each 365 MB (11.00)
model + 1to 3 MB for
each model
SoDA with Frame 64 MB 32 MB minimum 192 MB 252 MB
Purify! - 2-5 times application size | 16 MB 11 MB (32-bit)
12 MB (64 bit)
Quantify ! - 2-5 times application size | 15 MB 10 MB (32-bit)
12 MB (64 bit)
PureCoverage ! - 2-5 times application size | 9 MB 12 MB
ClearQuest NA 48 MB 115 MB 230 MB
RequisitePro Web NA NA NA NA
Interface
Totals 214 MB + 160 MB + 32 MB/user + 740 MB 940 MB
50 MB Zuser | Purify, Quantify, and
PureCoverage
requirements
Recommended 500 MB + 256 MB + 32 MB/user 09GB 1.3GB
Suite 50 MB/user

1 Swap Space requirements are dependent on the size of the application that is being tested.
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Table 5 Rational Suite DevelopmentStudio RealTime Hardware Requirements

Product Swap Space | Memory Disk Space

Solaris HP-UX
Rational Unified NA 16 MB minimum 57 MB 57 MB
Process
Rose RealTime 770 MB 256 MB minimum 355 MB 355 MB

+1to3MBfor |+ 1to3MB for

each model each model
SoDA with Frame 64 MB 32 MB minimum 192 MB 252 MB
Purify 1 - 2-5 times application size | 16 MB 11 MB (32-bit)

12 MB (64 bit)
Quantify 1 - 2-5 times application size | 15 MB 10 MB (32-bit)
12 MB (64 bit)
PureCoverage ! - 2-5 times application size | 9 MB 12 MB
ClearQuest NA 48 MB 115 MB 230 MB
RequisitePro Web NA NA NA NA
Interface
Totals 214 MB + 160 MB + 32 MB/user + 760 MB 905 MB
50 MB Zuser | Purify, Quantify, and
PureCoverage
requirements

Recommended 500 MB + 256 MB + 32 MB/user 0.9GB 1GB
Suite 50 MB/user
Requirements

1 Swap Space requirements are dependent on the size of the application that is being tested.

Software Requirements

The following platforms are supported in Rational Suite, version 2002.05.00:
= Solaris 2.6, 2.7 (Solaris 7), and 2.8 (Solaris 8)
»  HP-UX10.20, 11.00, and 11.11

Note the following point product exceptions:

= Rational Unified Process is not supported on HP-UX 10.20.
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Rational Rose RealTime is not supported on HP-UX 11.0 or 11.11. For more
information, see Installation Requirements for Rational Rose RealTime on page 35.

Each point product within Rational Suite has its own range of OS version
compatibility as summarized in Table 6. Customers should pick the OS version that

intersects the product mix they intend to use.

Table 6 Individual Product OS Version Compatibility
Product Solaris HP-UX
Rose 2.6, 2.7 (Solaris 7), and 2.8 | 10.20, 11.0, and 11.11

(Solaris 8)

See Table 7 for more information.

Rose RealTime!

2.6, 2.7 (Solaris 7), and 2.8
(Solaris 8)

10.20

SoDA with Frame

2.6, 2.7 (Solaris 7), and 2.8
(Solaris 8)

10.20, 11.0, and 11.11

Purify 2.6, 2.7 (Solaris 7), and 2.8 | 10.x through 11.0, and 11.11
(Solaris 8) 32 and 64 bit (narrow and wide mode)
(32 and 64 bit)

Quantify 2.6, 2.7 (Solaris 7), and 2.8 | 10.x through 11.0, and 11.11

(Solaris 8)
(32 and 64 bit)

32 and 64 bit (narrow and wide mode)

Pure Coverage

2.6, 2.7 (Solaris 7), and 2.8
(Solaris 8)

(32 bit only)

10.x through 11.0, and 11.11
32 bit only

ClearQuest

2.6, 2.7 (Solaris 7), and 2.8
(Solaris 8)

10.20, 11.0, and 11.11

Rational Unified Process !

2.6, 2.7 (Solaris 7), and 2.8
(Solaris 8)

11.0and 11.11
Note that Rational Unified Process is not
supported on HP-UX 10.20.

1 Requires an HTML browser. Netscape Navigator 4.7 or later is recommended.

Installation Requirements for Rational Rose

This section lists requirements that must be met to successfully use Rational Rose.
Table 7 summarizes the software requirements for Rational Rose.
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Table 7

Rose Software Requirements

HP aC++ B3910B A.01.21
HP aC++ B3910B A.01.19.02 Language Support Library

HP-UX 11.00:
HP aC++B3910B A.03.13
HP aC++B3910B X.03.11.10 Language Support Library

Software Item Requirement For

Operating system Solaris 2.6, 7, and 8 (kernel revision January 2000 and Use
I:E-%x 10.20 (ACE release 1), 11.00, and 11.11

C++ Compiler Solaris SC 5.0 Analyzer

#include files HP-UX 10.20:

JDK, JFC, and J2EE

JDK 1.1.6

JFC 1.1 (swing classes for 1.1)
JDK 1.2 (based on 1.2.1)

J2SE 1.2 (based on 1.2.2)

J2SE 1.3

J2EE 1.2

or any of the major Java IDEs

Java

Rose J supports the following Java IDE’s. Use the JDK
appropriate to your IDE. 2

= Forte for Java Internet Edition 2.0 & 3.0(Solaris &
Linux only)

= Forte for Java Community Edition 2.0 & 3.0(Solaris &
Linux only)

= JBuilder 4.0, 5.0, and 6.0 Professional Edition (Solaris
& Linux only)

= JBuilder 4.0, 5.0, and 6.0 Foundation Edition (Solaris &
Linux only)

Port map daemon

Must be running

Installation, Use

TCP/IP

Must be running

Installation, Use

Host names

Must be configured

Installation, Use

Page/swap space

150 + (50 * N) MB

Use
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Table 7 Rose Software Requirements (continued)

Software Item Requirement For

X Window System Native X11R5 or X11R6 (except HP 10.20) Use
X news on Sun with OpenWindows 3.

PC X server eXceed version 6.1 or higher

Window Manager MWM (Motif Window Manager) version 1.2 Use
vuewm on HP-UX
4dwm on SGI IRIX
dtwm (CDE (Desk Top) version 1.0)

olwm (Open Look Window Manager) on Sun is
supported, but icons of Rose may not integrate well with
other icons on the screen

The following Window Managers are not supported:

olvwm (olwm with virtual screens) Rose will not remain
on original virtual desktop, but rather will follow when
other desktops selected.

twm (shipped with X11)
tvtwm (twm with virtual screens)

1 Rose requires that an ACE release be installed to run properly on HP-UX 10.20. To determine if an ACE release is
installed, run /usr/sbin/swlist | grep ACE.

2 See the Rose_IDE_Link_README file in the release for Rose UNIX/Linux IDE Link Integration setup information,
prior to using the IDE Link integration.

Rational Rose - Operating System Runtime and Patch
Requirements

For information regarding Rational Rose runtime and operating system patch
requirements, see Appendix A, Rational Rose - Operating System Runtime and/or Patch
Requirements on page 137.

Patches are recommended for new customers and customers experiencing problems.
Contact Rational Technical Support if you encounter any compatibility difficulties
after installing a patch.
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Installation Requirements for Rational Rose RealTime

This section provides requirements that must be met to successfully use Rational Rose
RealTime.

If you plan to install Rational Suite DevelopmentStudio Real Time on HP-UX 11.0 or
11.11 and want to use Rational Rose RealTime, you must do the following:

1 You must install Rational Suite DevelopmentStudio RealTime on an NFS-mounted
drive that is accessible from an HP-UX 10.20 system.

2 Runs rs_setup from the HP-UX 10.20 system to set up the environment required to
run Rational Rose RealTime and other Suite products.

rs_setup is located in rational_dir (where rational_dir) is the directory in which you
installed the Suite.

Rational Rose RealTime - Operating System Patch Requirements

For information regarding Rational Rose RealTime operating system patch
requirements, go to the following web site:

http://www.rational.com/support/downloadcenter/patches

Patches are recommended for new customers and customers experiencing problems.
Contact Rational Technical Support if you encounter any compatibility difficulties
after installing a patch.

Installation Requirements Rational Rose RealTime Companion Products

You must install Rational Suite before you install any of the Rational Rose Real Time
Companion Products. The Rational Rose RealTime Companion Products are
provided with Rational Suite DevelopmentStudio RealTime. These products can
be installed from the Rational Rose Real Time Companion Products CD and include:

Rational Quality Architect
Rational Connexis

For more information about installing the Rational Rose RealTime Companion
Products, refer to the Release Notes and Installation Guide - Rational Rose RealTime
Professional Edition.

Installation Requirements for Rational SoDA

Note: FrameMaker + SGML is no longer shipped with SoDA. It must now be licensed
and installed independently. Rational SODA 2002.05.00 supports FrameMaker+SGML
5.5and 6.0.
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You may want to install FrameMaker + SGML 5.5 or 6.0 before you install Rational
Suite. Make a note of the FrameMaker + SGML installation directory as you need to
provide this during the installation.

Alternatively, you can go ahead and install Rational Suite and install FrameMaker +
SGML later. See Integrating Products That Are Not Part of the Suite on page 77 for
information about how to integrate FrameMaker + SGML with SoDA after you have
installed the Suite.

If you have previously installed version 3.0.1, 3.0.3, or 3.1.0 of Rational SODA, you
may choose to use the installation of FrameMaker+SGML bundled with that release.
To do this, copy the entire SODA directory to a new location and uninstall the
previous version of Rational Suite: this way, you do not accidentally remove the
previous version of Rational SODA when you uninstall the Suite. When you install
Rational Suite, be sure to install the new version of SODA, and when prompted for the
FrameMaker + SGML location, enter the path to the previous version.

Note: To optimize disk space by removing the SODA components and keeping only
the FrameMaker+SGML components, refer to Technical Application Note 17972 at the
following location: www.rational.com/support/.

Installation Requirements for Rational ClearCase LT

Rational ClearCase LT is included with on the Rational ClearCase LT (UNIX) CD. Your
Rational Suite DevelopmentStudio for UNIX (UNIX Components) or Rational Suite
DevelopmentStudio RealTime for UNIX (UNIX Components) license key can be used
to run ClearCase LT.

You must install Rational Suite before you install Rational ClearCase LT. When you
install Rational ClearCase LT you are prompted to provide the host name of the
Rational Suite license server. By doing the installation in this sequence, ClearCase LT
will be able to use the Rational Suite license key.

For more information about the requirements for installing Rational ClearCase LT, see
the Rational ClearCase LT Installation Guide.
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Rational Suite (Windows Components) Installation
Requirements

Installation Requirements for Rational TestManager

Rational TestManager is included with this release and is provided on the Rational
Solutions for Windows CD. Your Rational Suite DevelopmentStudio (Windows
Components) or Rational Suite DevelopmentStudio RealTime (Windows
Components) license key can be used to run Rational TestManager.

Note: You must install Rational Suite before you install Rational TestManager.

This product is run in a Windows environment. Before you can use Rational
TestManager with a UNIX environment, you must install the UNIX Agent from the
Rational Test Agent CD. For more information about requirements for installing
Rational TestManager and Rational Test Agent, see the Rational Testing Products
Installation Guide.

Installation Requirements for RequisitePro

RequisitePro is installed on the Windows platform and is accessed on UNIX through a
web interface. Installation requirements for RequisitePro are listed in this section.

Complete installation instructions can be found on the Rational Solutions for Windows
Online Documentation CD. You can also view the instructions online by typing
rsdsu_help.

Note: It is recommended that for best web server performance a dedicated Windows
Server system be configured.

Hardware Requirements
To run RequisitePro you need:
= Pentium 300 MHz or faster processor recommended
= 128 MB or more of memory
250 MB or more of disk space
800 x 600 x 256 color video resolution, or higher
Microsoft Mouse or compatible pointing device

= CD-ROM drive
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Licensing Requirements

Your Rational Suite DevelopmentStudio (Windows Components) or Rational Suite
DevelopmentStudio RealTime (Windows Components) license key can be used to run
Rational RequisitePro. This license can be served from a license server on UNIX or
Windows.

Note: If you are configuring your Windows system to get licenses from a UNIX
system, you will need to have DNS configured on your Windows system.

To check, try to ping the UNIX license server by name and by IP address. If
networking is okay, you should be able to ping the system by IP address. If DNS is
configured, you will be able to ping by name.

Installation Requirements for RequisiteWeb

RequisiteWeb provides a Web interface for accessing RequisitePro project data
through a Web browser.

Installation and configuration instructions can be found in
rational_dir/docs/html/reqweb_install/RequisiteWeblnstall.html. This document is available
through the documentation browser accessed through the rsdsu_help command.

Oracle and SQL Server Databases

To create and access RequisitePro projects in Oracle or Microsoft SQL Server
databases, you must configure an Oracle or SQL Server schema on your database
server, and install RequisitePro and RequisiteEnterprise on your client system.

Note: RequisiteEnterprise is available separately for Rational Suite users who require
access to these database servers.

RequisiteWeb Interface

The RequisiteWeb interface requires the installation of Web components on a
Microsoft Windows server and a Web browser on the client system.

Web Server

RequisiteWeb requires that it be installed on an Internet Information Server (I1S). If
you prefer to use the Personal Web Server (PWS), you can do so by performing a
“Custom Installation” and checking the box for Internet Service Manager.
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11S is the web server for Microsoft NT Server; PWS is the web server for Microsoft NT
Workstation. Since NT Workstation and Personal Web Server have a limited number
of connections, they are often not suitable for production use. However, you may find
it convenient to use Personal Web Server for evaluation or demonstration purposes.

The following table summarizes the requirements for the RequisiteWeb server.

RequisiteWeb Component

Disk Space

Operating System

One of the following:

= Microsoft Windows 2000 Advanced Server
= NT Server 4.0, Service Pack 6A or later

= NT 4.0 Option Pack

HTTP Server

One of the following:

= Internet Information Services (11S) 4.0 and Microsoft
Transaction Server (MTS) 2.0

= Internet Information Services (11S) 5.0

Processor 400 MHz or greater

Memory 128 MB. For projects with more than 10,000 requirements or
Web sites with more than 10 concurrent users, 256 MB or
more is recommended.

Disk space RequisiteWeb (includes system DLLs) — 40 MB

Other products

= Microsoft Word 2000
= Microsoft Word 2002

= Oracle, version 7.3, 8.1.5, 8.1.6, 8.1.7 client software (for
accessing projects in an Oracle database)

= Microsoft Internet Explorer 5, 6
or Internet Explorer 4 with the XML parser available at
http://msdn.microsoft.com/downloads/tools/
xmlparser/xmldl.asp

Web Interface Client

To use the RequisiteWeb interface requires that a web browser be available. rs_install

will install a version of Netscape that is compatible with RequisiteWeb. No additional
client installation is required for use of the RequisiteWeb interface. If you choose not

to use the supplied version of Netscape, the following web browsers should be

compatible:

= Microsoft Internet Explorer 4.x or later

= Netscape Communicator 4.x or later
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Netscape Navigator 4.x for UNIX or later

Installation Requirements for Rational ClearQuest Web

Rational ClearQuest is provided on UNIX; however, you may use your Rational Suite
(Windows Components) license key to install Rational ClearQuest on Windows.
Installing ClearQuest allows UNIX users to access ClearQuest through their web
browser.

For installation requirements for ClearQuest Web, refer to the Rational ClearQuest
Installation manual. If you are performing a full installation of ClearQuest, refer to the
ClearQuest documentation provided on the Rational Solutions for Windows Online
Documentation CD in addition to the Rational ClearQuest Installation manual.

Planning Your Installation

Rational Suite is designed to work in a distributed environment. Both Solaris and
HP-UX versions are available, and both may be installed on the same network.

For the purposes of installation, your computers assume roles as depicted in Figure 1.
Note that these roles are generalized; in practice, any particular computer can serve
more than one role. In fact, this is typically the case. In many installations, the roles of
the storage host, license server, install client, and exec client are provided by a single
UNIX server. A separate Windows server is still required to act as the RequisitePro
server.

Storage Host

This is the computer that hosts the physical disks on which the product will be
installed. All computers with UNIX roles must have access to the installation
directory on this disk, presumably through NFS. (Operating System: Solaris or
HP-UX).

X-server

This is any computer, typically an engineering workstation, which provides an
X-Windows display to the end user. This role is shown for completeness; its operation
is transparent to the installation.
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RequisitePro Server

This Windows computer hosts the Rational RequisitePro component. This server is
only needed if you are going to use RequisitePro. See the RequisitePro document for
more information. Access to RequisitePro from a UNIX client is provided through
Rational RequisiteWeb.

Note: You cannot have two different versions of Rational Suite installed on the same
Windows server.

Figure 1 Installation Computer Roles

Storage Host License Server
(Solaris, HP-UX) (Solaris, HP-UX, Window s)

X Server
(Solaris, HP-UX)

Install Client Execution Client RequisitePro
(Solaris, HP-UX) (Solaris, HP-UX) Server
{(Windows)
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License Servers

These computers provide licensing for Rational Suite. License server configurations
are described in more detail in License Server Configurations on page 42.

Note: In most cases, it is possible to use the same license server to manage Suite
licenses and individual point-product licenses; however, some exceptions apply. For
example, ClearDDTS and Rational Suite licenses cannot be served by the same license
server. This configuration requires that two separate license servers be set up on two
different UNIX systems.

Install Client

This is simply the computer on which you run the installation utility. Typically, this is
the same computer as the storage host. (Operating System: Solaris or HP-UX)

Execution Client

This is any computer which will execute the component products. There may be any
number of execution clients on your network. (Operating System: Solaris or HP-UX)

Note that you only need to install the UNIX Components once, on the install client
and storage host. Individual workstations (execution clients) may simply run the
installed software from the single installation area.

License Server Configurations
Rational Suite supports three license server configurations:
= Single server configuration
= Two server configuration

» Redundant server configuration

Single Server Configuration

As shown in Figure 2, the single server configuration uses a single UNIX server to
manage licenses for both UNIX Components and Windows Components. This is the
recommended configuration because it is the simplest to manage.
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Figure 2  Single Server Configuration

—

—
TR

UNIX Server for
UNIX Components and
Windows Components
(Solaris, HPUX)

Two Server Configuration

As shown in Figure 3, a two-server configuration uses a UNIX server to manage
licenses for UNIX Components and a Windows server to manage licenses for the
Windows Components. Information on installing the Windows license server is
provided in Installing the Rational License Server Software on Windows on page 97.

Figure 3  Two Server Configuration

UNIX Server for Windows Server for
UNIX Components Windows Components
(Solaris, HP-UX) (NT, Windows)

Redundant Server Configuration

As shown in Figure 4, a redundant server configuration uses three UNIX servers to
manage licenses in a fault-tolerant configuration known as redundancy. The
redundant server configuration is described in more detail in Setting up Redundant
License Servers on UNIX on page 87.
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Figure4 Redundant Server Configuration
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Installation Worksheet

The following worksheet is provided for convenience in planning the installation.
Note that some parts may not be known until you begin the installation.
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Table 8 Installation Worksheet

Storage Host

Host name

Installation directory (rational_dir
location)

Installation user name (not root)

Install Client

Host name

Install user name (not root)

License Server

Host name for UNIX licenses
License port (default=27000)
License file

Host name for Windows licenses

License port

RequisitePro Server

Host name

URL for RequisiteWeb

Sample Exec Client

Host name

Installation Worksheet
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Understanding Rational
Suite Licensing

This chapter describes the following topics related to Rational software licensing
services:

The Rational Common Licensing Model on page 47
Types of Licenses on page 48
o Node-Locked Licenses on page 48
o Permanent Licenses and Temporary License Keys on page 49
o Emergency and Evaluation Keys on page 49
= Requesting License Keys on page 51
Requesting License Keys by Fax on page 53

Converting a Temporary License to a Permanent License on page 54

The Rational Common Licensing Model

Rational Software uses a software-based license management tool from GLOBEtrotter
Inc. called FLEXIm. FLEXIm provides users with a powerful and flexible mechanism
for managing licensing. This allows vendors such as Rational Software to build a
customized licensing model by implementing the FLEXIm features that best meets
their business needs.

Products Included in Rational Common Licensing
The following list of Rational software products use Rational Common Licensing:
Rational Rose
Rational Rose Real Time
= Rational ClearQuest
= Rational RequisitePro and Rational RequisiteWeb

= Rational ClearCase LT
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Rational SoDA
Rational testing products
Rational Developer Tools
= Rational Suite DevelopmentStudio for UNIX
= Rational Suite DevelopmentStudio RealTime for UNIX

Products Not Included in Rational Common Licensing
Rational Developer Tools on UNIX (before the August 2000 release)
Rational Apex
Rational ClearCase
- Rational ClearDDTS
= Rational VADS

Types of Licenses

Node-Locked Licenses

Node-locked licenses are created only for a specific system. A node-locked license can
be a permanent license, a term license agreement (TLA), or it can be an evaluation
license.

Note: Because node-locked licenses are uncounted licenses, there is no need to have a
license server process running to manage their use.

Floating Licenses

Floating licenses are licenses that can be shared by multiple users on multiple
systems. A Rational license server controls use of the floating licenses.

Note: Users need floating license keys from a Web server to run Rational ClearQuest
Web and Rational RequisiteWeb on Web clients.

Floating licenses allow anyone on your network to use Rational Suite as long as a
license is available. Thus, the number of licenses that you purchase determines the
maximum number of users who can use Rational Suite concurrently.
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Permanent Licenses and Temporary License Keys

When you register Rational products to specific systems (license server or client) in
AccountLink, Rational generates license keys and sends you an e-mail message with
these permanent license keys in a license file. The permanent keys let you use the
Rational products for an indefinite period of time. However, Rational assigns an
expiration date to the license keys if your company has negotiated a Term License
Agreement (TLA). Technically, TLA keys are not permanent, but the process of
ordering and installing TLA licenses is the same as a permanent license.

To use Rational products for an evaluation period or if you expect a delay in receiving
your permanent keys, you can install the temporary license key provided in your
Rational License Key Certificate. Because Rational has not generated the temporary
key for a specific system, you can use it on any system until the specified expiration
date.

Permanent and temporary license keys can be floating or node-locked. The difference
is that a temporary key is not generated for a specific system and a permanent key is
generated for a specific system.

Emergency and Evaluation Keys

Emergency and evaluation license keys are temporary license keys. They can be
floating or node-locked. They are short-term licenses that are not generated for a
specific system.

Suite Licenses and Point Product Licenses

A Rational license key indicates whether it is a Rational Suite license, such as Rational
Suite DevelopmentStudio, or a point-product license, such as Rational Purify. A
Rational license file can contain multiple floating or node-locked Suite and
point-product license keys.

Returning License Keys

You may heed to replace an old system or decide another system should act as the
new Rational license server. Because permanent license keys are tied to a system’s
host ID, Rational products will not work on another system until you import new
license keys that are tied to the new system’s host ID.

To get your new license key, you need to “return” the existing license key back to your
Rational account and then order a license key for the other system.
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When you return a license key, you do not physically give the license key back to
Rational. Instead, the return transaction updates Rational’s records to indicate that
you are no longer using the software on that system. This adjusts the count of
registered products in your account and allows you to get the license key for the other
system.

In accordance with the Legal Agreement provided on AccountLink, you have 30 days
to shut down the license server that corresponds to the server identified in the
returned license file. If you have a license file that contains more than one license and
you are returning only one of those licenses, remove the entry for the license that you
are returning. When you have finished editing the file, use the Imreread command to
reread the license file and restart the vendor daemon. For more information about
licensing commandes, see License Manager Commands on page 109.

Upgrading Licenses

If you are upgrading from an earlier version of a Rational Suite or point-product, you
can reuse your current Rational Suite and point-product license keys.

Adding Point Products to Licenses

If you are adding a new product to your system, you have to request a new license file
that includes the new point-product license key. You cannot use the Suite license for
individual point-product installations.

Using Your Rational License Key Certificate

To get your permanent or TLA license keys, you need to supply information from
your Rational License Key Certificate. This certificate is enclosed in a large green
envelope in your shipment. The information, especially the Rational Account
Number, on this certificate verifies that your company has purchased licenses to run
Rational products.
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License Usage Order

A Rational product, whether it is installed as part of a Rational Suite or installed
individually, requests licenses in this order, by default:

1 Node-locked before floating license
2 Suite license before point-product license

A Rational product requests a node-locked license before a floating license, regardless
of whether it is a Suite or point-product license. Then, among a group of floating or
node-locked licenses, a product requests a Suite license before a point-product license.
For example, Rational Purify is sold as part of a Rational Suite and as a stand-alone
product. It will request the Rational Suite license before it requests a Rational Purify
license.

If you would like to change how your Rational products use Suite and point-product
licenses, see Customizing License Usage Order on page 110.

Rational RequisiteWeb and ClearQuest Web

Rational RequisiteWeb and ClearQuest Web require floating licenses. Unlike other
Rational products, they request the point-product license before the Suite license.

Rational ClearCase LT

Rational ClearCase LT can use either a ClearCase LT (floating) license or a Rational
Suite (node-locked or floating) license.

Note: Rational ClearCase LT licenses are managed differently from other point
products. Rational ClearCase LT uses a linger feature that requires a user to claim a
license for a minimum period of 30 minutes. After 30 minutes has elapsed, the license
is returned and made available to other users.

Requesting License Keys

AccountLink (http://www.rational.com/accountlink) is a Web tool that you can use to
manage your permanent (or Term License Agreement) license keys. To use
AccountLink, you need the License Key Certificate to order and install your license
keys. AccountLink’s interface offers three license transactions:

Get License Key(s)

Return License Key(s)
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Request a Copy of a License File

With these three transactions, you can order and return permanent license keys for
Windows and UNIX products from single or multiple Rational accounts.

Note: AccountLink does not support temporary license key transactions.

AccountLink requires you to register your Rational software to specific systems using
the system’s host ID or ethernet address. You can register:

= Rational Windows or UNIX products that will be served from a Rational license
server.

Single or redundant Rational license servers on Windows or UNIX systems.

= Remote Windows or UNIX systems; you do not need to sit at the system for which
you are requesting license keys.

If you are not at the computer for which you are requesting license keys, you must
have the following information available: Hosthame and Host ID. You can
download a tool from AccountLink that provides this information automatically
for you.

Alternatively, you can run rs_hostinfo directly from the CD to get the host
information. This applies to UNIX host information only. To obtain information
about a Windows host, you need to use the download tool.

The following license key types are supported in Rational Suite:

Component type License type

Rational Suite DevelopmentStudio (UNIX Components) Node-locked and floating
Rational Suite DevelopmentStudio RealTime (UNIX

Components)

Rational Suite DevelopmentStudio (Windows Components) | Floating

Rational Suite DevelopmentStudio RealTime (Windows
Components)

Note: You must request license keys twice if you plan to use any of the Windows
Components. You must request a license for the UNIX Components and you must
request a license for the Windows Components.
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Receiving and Importing License Keys

After you register your Rational products to a specific system with AccountLink,
Rational generates a license key file that contains the license key. The file is sent in an
e-mail message to the contact e-mail address that you designate in AccountLink’s
License Contact page.

You need to save the file to a known directory location as you will need to provide this
information when you install the Rational software.

Note: If AccountLink is unavailable, see Requesting License Keys by Fax on page 53 or
call Rational Licensing Support. See Contacting Rational Licensing Technical Support on
page xvii for Support phone numbers.

Requesting License Keys by Fax

This section summarizes the steps for getting a node-locked or floating permanent
license key when Rational AccountLink is unavailable.

Although this section gives customers instructions for obtaining license keys by fax,
Rational recommends that you use Rational AccountLink
(www.rational.com/accountlink) to request permanent license keys.

1 Find your License Key Certificate in your Rational product shipment.
2 Print the license request form.

The documentation browser can be used directly from the CD-ROM and from the
installed product area. To view the form directly from the CD-ROM, run the
command rs_help from the CD-ROM root directory. The form, is located in the
HTML Tool Documentation/Rational Suite DevelopmentStudio/FAX License Request Form.

3 Use the License Key Certificate to fill out the form. Make sure that the contact,
Rational account number, product, licensing, and host information are correct.
Any errors will cause delays in receiving your license keys.

Note: If you are requesting a node-locked license, be sure to select NodeLocked
and not NodeLocked UNIX. NodeLocked UNIX does not apply to Rational Suite.

4 Fax the request to Rational. See Contacting Rational Licensing Technical Support on
page xvii for fax and phone numbers.

If you request a permanent license key by fax and you have specified an e-mail
address in your contact information, you will receive a license key file through e-mail.
You can copy the permanent license file from the e-mail enabled system and install it
on the system that is not e-mail enabled.
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Requesting License Keys by Phone

If you cannot provide an e-mail address, contact Rational Licensing Support by
phone. See Contacting Rational Licensing Technical Support on page xvii for the phone
numbers.

Converting a Temporary License to a Permanent License

If you initially used a temporary license (evaluation or startup) to install Rational
Suite, you can convert your license to a permanent license by using the license_setup
command. The license_setup command allows you to run a subset of the install script,
rs_install. The license_setup command allows you to set up license options and run
the license check sequence.

You may also do this by running rs_install; however, using license_setup will save
you time as there is no need to run through a full product installation or any of the
post product installation setup.

You need to have a permanent or TLA license before you start. See Requesting License
Keys on page 51.
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Installing the Product

This chapter details how to install Rational Suite and includes the following topics:
= Upgrading Rational Suite on page 55
Installing Rational Suite (UNIX Components) on page 57
o Installing Rational Suite DevelopmentStudio on page 58
o Installing Rational Suite DevelopmentStudio Real Time on page 66
= Installing the Online Documentation on page 74
= Verifying Your Installation on page 76
* Running the User Setup Script on page 76
Integrating Products That Are Not Part of the Suite on page 77
Changing the Primary RUP Variant on page 78
= Installing Rational Suite (Windows Components) on page 78
= Configuring and Testing RequisiteWeb on page 81
= Removing the Rational Suite Software on page 82
Next Steps on page 85

Note: If you have not reviewed Before You Install on page 27, you should do so before
proceeding.

Upgrading Rational Suite

Upgrading from Version 2001A.04.00 or 2000.02.10

If you are upgrading from version 2001A.04.00 or 2000.02.10, you may use your
existing license.



1

Install the product by running rs_install. For complete instructions, see Installing
Rational Suite (UNIX Components) on page 57.

Choose option 1, use an existing FLEXIm license file, from the Licensing Options
Menu.

After you have completed the upgrade, you may wish to remove the previous
version to recover disk space. See Removing the Rational Suite Software on page 82.

If you have previously installed version 3.0.1, 3.0.3, or 3.1.0 of Rational SoDA, you
may choose to use the installation of FrameMaker+SGML bundled with that
release. To do this, copy the entire SODA directory to a new location and uninstall
the previous version of Rational Suite. This way, you do not accidentally remove
the previous version of Rational SODA when you uninstall the Suite.

Note: To optimize disk space by removing the SoODA components and keeping
only the FrameMaker+SGML components, refer to Technical Application Note
17972 at the following location: www.rational.com/support/.

Upgrading from a Release Prior to Version 2000.02.10

As of version 2000.02.10, all license management is done through Rational
AccountLink, a new online licensing web tool. You need to return your old license
keys and request new license keys before you can install Rational Suite. For
information, see Requesting License Keys on page 51.

1

Install the product by running rs_install. For complete instructions, see Installing
Rational Suite (UNIX Components) on page 57.

Choose option 2, setup a permanent or term-license-agreement, from the Licensing
Options Menu.

After you have completed the upgrade, you may wish to remove the previous
version to recover disk space. See Removing the Rational Suite Software on page 82.

If you have previously installed version 3.0.1, 3.0.3, or 3.1.0 of Rational SoDA, you
may choose to use the installation of FrameMaker+SGML bundled with that
release. To do this, copy the entire SODA directory to a new location and uninstall
the previous version of Rational Suite. This way, you do not accidentally remove
the previous version of Rational SODA when you uninstall the Suite.

Note: To optimize disk space by removing the SoODA components and keeping
only the FrameMaker+SGML components, refer to Technical Application Note
17972 at the following location: www.rational.com/support/.
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Installing Rational Suite (UNIX Components)

This section provides instructions about how to install the UNIX products that are
part of Rational Suite. The rs_install command is a complete installer that includes
licensing setup, license checking, product installation, and product setup. Rational
recommends that you follow the menus and prompts and allow rs_install to guide
you through the installation.

Default values, where provided, are enclosed in square brackets. To accept the default
value, simply press the Enter key.

Note: The term rational_dir is used throughout this guide to refer to the directory in
which you install Rational Suite.

Installing in Secure Environments

Problems may occur when trying to perform a remote installation of Rational Suite in
a secure environment (for example, remote access to other machines is through ssh) if
the environment does not have access to rsh or remsh. To install Rational Suite in this
situation, perform a local installation of the software rather than a remote installation.
If you experience further problems, contact Rational Technical Support.

Installing Multiple OS Versions of Rational Suite

If you wish to install different OS versions of Rational Suite (for example, Solaris and
HP-UX) on the same file server, it is recommended that you install them in different
Rational directories (referred to as rational_dir). If you install them into the same
Rational directory, you will not be able to uninstall a single OS version later, if
necessary. The uninstall script will remove all OS versions that reside in the same
Rational directory.

Stopping and Restarting an Installation

You can stop an installation by entering g to quit the installation. If you choose g, most
of your input is saved in a user defaults file that is located in rational_dir/config/defaults.
The file name itself is in the following format: rs_install.release_name.user_name.

The user defaults file contains general purpose defaults specific to you and the license
server that you configure. It also keeps track of the product-specific information for
the installation of this specific Suite and version.

Note: If you enter q!, your entries are not saved to the user defaults file.
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You can restart the installation by running rs_install again.You should notice that
many of your entries appear as the default value. Simply press the Enter key to
continue with the installation. After you get to the Enter Install Mode screen you can
choose one of three options:

= Ask - if you want to be prompted whether or not to reinstall the product

= Skip —if you want rs_install to automatically skip any product that has already
been installed

Reinstall - if you want rs_install to automatically uninstall and reinstall the
product.

Installing Rational Suite DevelopmentStudio
Use the following procedure to install Rational Suite DevelopmentStudio.
To install Rational Suite DevelopmentStudio:
1 Log on to the install client. This can be any UNIX computer that:
o Gives you access to a CD-ROM drive
o Mounts the file system into which you will load the Rational Suite release

o Runs the operating system specified on the Rational Solutions for UNIX CD
(Solaris 2.6, Solaris 7 or Solaris 8; or HP-UX 10.20, 11.0 or 11.11)

Note: You do not need to be root to install the product.
2 Place the Rational Solutions for UNIX CD in the CD-ROM drive.

If the CD-ROM drive is not mounted, supplemental instructions can be found in
the appendix, Accessing the CD-ROM Drive on page 145.

3 Run the installation script, rs_install, which is located at the root level of the CD.
./Irs_install

rs_install can be invoked with a number of options. For example, the -no_log (-nl)
option can be used to stop rs_install from creating a log file. To see a listing of all
available options, run rs_install -help.

4 Enter the directory where you will install Rational Suite DevelopmentStudio.

Note: For the Rational directory, supply a pathname such as: /vendor/rational. The
directory needs to be visible on all computers from which you want to run this
product, and must be writable by the installer’s user name. Also, the NFS name for
the directory must be the same on all computers.

5 Read through the license agreement and answer yes (y) to accept the terms.

58 Chapter 4 - Installing the Product



6 Choose option 1 from the Product and License Configuration Selection Menu. The
following table summarizes all of the options for this menu.

Option Description

1 Choose this option to install Rational Suite DevelopmentStudio.

2 Choose this option to install Rational Suite DevelopmentStudio RealTime.
Note: This option does not apply if you are installing Rational Suite
DevelopmentStudio.

3-8 Choose one of these options to install an individual point product.

Note: You need to have a license key for the individual point product specified.

These options are not intended to be used with a Suite license.

Refer to the appropriate point product installation guide and release notes for

further instructions on how to install these products:

= Rational Rose Installation Guide

= Rational Rose Real Time Installation Guide

= Rational SoDA Installation Guide

= Installing and Getting Started: Rational Purify Plus, Rational Purify, Rational
PureCoverage, Rational Quantify (Options 6 and 7)

= Rational ClearQuest Installation Guide

9 Choose this option to run the license setup only and to bypass installing any
applications. You can also use this option to start a license server process for
other Rational products.
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7 Choose your license option from the Licensing Options Menu. Options are
summarized in the following table.

Option

Description

1

Choose this option if you already have an existing license file for version
2000.02.10 or later of Rational Suite.

Note: Rational has changed the way licenses are handled in version 2000.02.10.
If you are upgrading from a release prior to version 2000.02.10, you should
select option 2. Before you do so, you will need to return your old license key
and request a new license key through AccountLink. For more information see
Requesting License Keys on page 51.

Caution: Selecting this option will not upgrade the license server software
automatically. It is highly recommended that you upgrade the license server
software from FLEXIm 6.0i to FLEXIm 7.0f if you have not already done so.
This will allow you to take advantage of the new features and help optimize
your license server’s performance. If you choose not to upgrade and experience
frequent problems such as internal errors or vendor daemon errors, you should
upgrade the license server software as a first step to addressing these issues. To
do this, run rs_install again, select option 2, and enter the license key manually
(see step 11).

Choose this option if you have a permanent license key or a Term License
Agreement (TLA).

This is a full installation that upgrades both the Rational Suite products and the
license server software (FLEXIm 7.0f).

Note: You need to have either the license file (filename.upd) stored in a known
location on the license server or you need a printout of the contents of the
license file available to proceed with the installation. rs_install prompts you to
provide the location of the license file or gives you the option to enter the
license key information manually. If you do not have a license file containing
your license keys, see Requesting License Keys on page 51.

Choose this option if you do not have a permanent license yet and you want to
install the product immediately, or if you want to install the product for
evaluation purposes.

Because the license keys are uncounted, option 3 does not start the license
server as part of the license check. A license server process is started if you are
serving both UNIX and Windows evaluation licenses on a UNIX license server.
This is because the Windows License Key Administrator (LKAD) requires the
port and host information (port@host) when configuring access to a UNIX
license server.

This is a full installation that upgrades both the Rational Suite products and the
license server software (FLEXIm 7.0f).

Note: You need to have your license key certificate available as rs_install
prompts you for information contained in the certificate.
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8

9

10

11

12

Do one of the following:

o If you are using an existing license, go to Step 9.

o If you are using a temporary license, go to Step 10.

o If you are using a permanent license, go to Step 11.

Enter the path to the license file or enter the port information.

Note: If the license server is running, it is preferable to specify the port. Enter
port@host, where port is the TCP/IP port number used by the license server and
the host is the hostname of the license server.

Go to Step 13.

Enter the temporary license key information from your license key certificate:
o License key

o License type

o Expiration date

Note: You are prompted for your license key information for both the Rational
Suite DevelopmentStudio (UNIX Components) and Rational Suite
DevelopmentStudio (Windows Components). If you are using a UNIX license

server to manage the Windows Components licenses, enter your temporary license

key information. If you are using a Windows server to manage licenses for the
Windows Components, or you do not plan to use the Windows Components,
enter 0.

When you have finished, go to Step 13.

Provide your license file information by doing one of the following:

o Import the information from the license file automatically by giving the path to
the .upd file. This is the file that AccountLink sends to an e-mail account when
you request a license. It has the filename format similar to license_for_server.upd.

o Enter none to provide the license key information manually. You will need a
printout of the content of the .upd file. Follow the prompts to enter the
information.

Define the location for the license.dat file that will be created from the information

supplied by the license_for_server.upd file. By default, rs_install creates the
license.dat file and stores it in the rational_dir/config directory.

Choose either the default path (option 1) that rs_install has selected or choose
option 2 to specify an alternate path.

Installing Rational Suite (UNIX Components)

61



13 Proceed with the License Check Menu. Do one of the following:

o If you are using an existing license, run through options 1 and 3. Note that
these options are the default settings provided by rs_install. There is no need to
restart the license server (option 2) if it is already running.

o If you are using a permanent floating license, run through options 1-3
sequentially and forward to the next menu. If you are setting up a permanent
node-locked license, run through option 1 only. Note that these options are the
default settings provided by rs_install.

o If you are using a Rational Suite (UNIX Components) temporary license, run
through option 1 and forward to the next menu. If you are using a Rational
Suite (Windows Components) temporary license, run through options 1-3
sequentially and forward to the next menu. Note that these options are the
default settings provided by rs_install.

14 The Product Customization Menu allows you to refine your Suite product
installation. The default settings for Rational Suite DevelopmentStudio (Solaris)
are shown in Figure 5. The default settings for Rational Suite DevelopmentStudio
(HP_UX) are shown in Figure 6. To change the installation setting between yes and
no, enter the product number. Once you have the settings you desire, enter f to
forward to the next menu.

Note: To accommodate heterogeneous environments, the Product Customization
Menu gives you the ability to install Rational Unified Process (RUP) for IBM and
Microsoft environments on a UNIX server. The default installation settings install
the UNIX version of RUP (classic) but you may install any or all variants to
support existing clients running in IBM or Microsoft environments. To install other
versions of RUP, enter the corresponding number for the variant that you want to
install. To deselect the classic version of RUP, enter its number to change the
selection to no.

Note: Actual file sizes may vary from that shown in Figure 5 and Figure 6.
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Figure5 Product Customization Menu: Solaris
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Figure 6 Product Customization Menu: HP-UX
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15 The Rational Rose Product Component Customization Menu allows you to
customize your Rose installation. This menu only applies if you are installing
Rational Suite DevelopmentStudio. To change the installation setting between yes
and no, enter the product number. Once you have the settings you want, enter f to
forward to the next menu.

Warning: Some components have dependencies and deselecting one may affect the
execution of another. Contact Rational Technical Support for more
information about component dependencies.

16 The SoDA Product Configuration Menu allows you to customize your SoDa
installation. Options are summarized in the following table. Note that all options
install SODA demos and training files.

Option Description

1 Choose this option if you want to integrate Rational SODA with Rational Rose
and Rational ClearQuest. This option applies to Rational Suite
DevelopmentStudio.

2 Choose this option if you want to integrate Rational SODA with Rational Rose
Real Time and Rational ClearQuest. This option applies to Rational Suite
DevelopmentStudio RealTime.

Note: To use this option, you need to have Rational Rose RealTime installed,
either as a point product or as part of Rational Suite DevelopmentStudio
RealTime edition of Rational Suite.

3 Choose this option if you want to integrate Rational SODA with Rational Rose.
This option applies to Rational Suite DevelopmentStudio.

4 Choose this option if you want to integrate Rational SODA with Rational Rose
RealTime. This option applies to Rational Suite DevelopmentStudio RealTime.

Note: To use this option, you need to have Rational Rose RealTime installed,
either as a point product or as part of Rational Suite DevelopmentStudio
RealTime edition of Rational Suite.

5 Choose this option to install all Rational SoDA domains (Apex, Rose, Summit,
TestMate, ClearCase, ClearQuest, and Rose RealTime).

Note: To use this option, you need to have Rational Rose RealTime installed,
either as a point product or as part of Rational Suite DevelopmentStudio
RealTime edition of Rational Suite.

17 The SoDA Product Component Customization Menu allows you to customize your
SoDA installation. To toggle the installation setting between yes and no, enter the
product number. After you have the settings you want, enter f to forward to the
next menu.
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19

20
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25

The Install Documentation Menu allows you to install online documentation for
Rational Purify, Quantify, and PureCoverage.

The Enter Install Mode menu allows you to decide whether you want rs_install to
prompt you before it reinstalls a product, skip a product if it is already installed on
your system, or reinstall the product without confirmation.

The installation process starts.

You are prompted to configure the cache directory for Rational Purify, Rational
PureCoverage, and Rational Quantify. Do one of the following:

v Enter no to accept the default directory.
o Enter yes to specify an alternate location and follow the prompts.

The following prompt is displayed if you are installing Rational Suite
DevelopmentStudio:

Are you configuring Rose to work with Apex?

Enter a value Yes or No. If you chose Yes, you will need to provide the path to the
Apex directory.

Define the read/write privileges: Owner writable, Owner and group writable, or
Writable by all.

Are you configuring SODA to work with Apex? Enter a value Yes or No.
If you chose Yes, you will need to provide the path to the Apex directory.
Enter the FrameMaker + SGML directory. Do one of the following:

o If you do not have FrameMaker + SGML installed on your system, enter none.
Continue with the installation and see Integrating Products That Are Not Part of
the Suite on page 77 after you have finished installing.

o If you have FrameMaker + SGML installed, enter the path.

Note: This release of SODA does not include FrameMaker + SGML. You need to
have either version 5.5 or 6.0 installed to use SoDA.

Use ClearQuest with SODA? Enter a value Yes or No.

If you choose Yes, you will be prompted to provide the path to the ClearQuest
installation. If you chose to install ClearQuest in Step 14, the default path is
rational_dir/releases/ClearQuestClient.2002.05.00. You can accept the default or
specify another path.
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26 The Web Setup Menu allows you to enter the URLSs for a Requisite Web server or a
ClearQuest Web server. These applications run on a Windows server and can be
accessed by UNIX developers through a web browser. Do one of the following:

o If you do not plan to use these web interfaces, enter none.

o If you do not know the URL for these servers, enter none and run the
web_setup command after you have the URLs.

o If you know the URLSs, enter them now.

27 If you chose to install more than one Rational Unified Process variant in Step 14,
you are prompted to select which variant you wish to use as the primary. Enter an
option (1-3) to select the primary variant. The default setting is the UNIX (classic)
version of RUP.

Note: You may change the primary RUP variant at any time by running the
post_install command. For more information see Changing the Primary RUP Variant
on page 78.

The installation of the Rational Suite DevelopmentStudio is now complete.

Installing Rational Suite DevelopmentStudio RealTime
Use the following procedure to install Rational Suite DevelopmentStudio RealTime.
To install Rational Suite DevelopmentStudio RealTime:
1 Log on to the install client. This may be any UNIX computer that:
v Gives you access to a CD-ROM drive
o Mounts the file system into which you will load the Rational Suite release

o Runs the operating system specified on the Rational Solutions for UNIX CD
(Solaris 2.6, Solaris 7, or Solaris 8; or HP-UX 10.20)

Note: You do not need to be root to install the product.
2 Place the Rational Solutions for UNIX CD in the CD-ROM drive.

If the CD-ROM drive is not mounted, supplemental instructions can be found in
the appendix, Accessing the CD-ROM Drive on page 145.

3 Run the installation script, rs_install, which is located at the root level of the CD.
./Irs_install

rs_install can be invoked with a number of options. For example, the -no_log (-nl)
option can be used to stop rs_install from creating a log file. To see a listing of all
available options, run rs_install -help.
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4 Enter the directory where you will install Rational Suite DevelopmentStudio

RealTime.

Note: For the Rational directory, supply a pathname such as: /vendor/rational. The
directory needs to be visible on all computers from which you want to run this
product, and must be writable by the installer’s user name. Also, the NFS name for
the directory must be the same on all computers.

5 Read through the license agreement and answer yes (y) to accept the terms.

6 Choose option 2 from the Product and License Configuration Selection Menu. The
following table summarizes all of the options for this menu.

Option Description
1 Choose this option to install Rational Suite DevelopmentStudio.
Note: This option does not apply if you are installing Rational Suite
DevelopmentStudio RealTime.
2 Choose this option to install Rational Suite DevelopmentStudio RealTime.
3-8 Choose one of these options to install an individual point product.
Note: You need to have a license key for the individual point product specified.
These options are not intended to be used with a Suite license.
Refer to the appropriate point product installation guide and release notes for
further instructions on how to install these products:
= Rational Rose Installation Guide
= Rational Rose Real Time Installation Guide
= Rational SoDA Installation Guide
= Installing and Getting Started: Rational Purify Plus, Rational Purify, Rational
PureCoverage, Rational Quantify (Options 6 and 7)
= Rational ClearQuest Installation Guide
9 Choose this option to run the license setup only and to bypass installing any
product applications. You can also use this option to start a license server
process for other Rational products.
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7 Choose your license option from the Licensing Options Menu. Options are
summarized in the following table.

Option

Description

1

Option 1 does not apply to Rational Suite DevelopmentStudio RealTime.

2

Choose this option if you have a permanent license key or a Term License
Agreement (TLA).

This is a full installation that upgrades both the Rational Suite products and the
license server software (FLEXIm 7.0f).

Note: You need to have either the license file (filename.upd) stored in a known
location on the license server or you need a printout of the contents of the
license file available to proceed with the installation. rs_install prompts you to
provide the location of the license file or gives you the option to enter the
license key information manually. If you do not have a license file containing
your license keys, see Requesting License Keys on page 51.

Choose this option if you do not have a permanent license yet and you want to
install the product immediately, or if you want to install the product for
evaluation purposes.

Because the license keys are uncounted, option 3 does not start the license
server as part of the license check. A license server process is started if you are
serving both UNIX and Windows evaluation licenses on a UNIX license server.
This is because the Windows License Key Administrator (LKAD) requires the
port and host information (port@host) when configuring access to a UNIX
license server.

This is a full installation that upgrades both the Rational Suite products and the
license server software (FLEXIm 7.0f).

Note: You need to have your license key certificate available as rs_install
prompts you for information contained in the certificate.

8 Do one of the following:.

o If you are using a temporary license, go to Step 9.

o If you are using a permanent license, go to Step 10.

9 Enter the temporary license key information from your license key certificate:

o License key

o License type

v Expiration date

Note: You are prompted for your license key information for both the Rational
Suite DevelopmentStudio RealTime (UNIX Components) and Rational Suite
DevelopmentStudio RealTime (Windows Components). If you are using a UNIX
license server to manage the Windows Components licenses, enter your temporary
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license key information. If you are using a Windows server to manage licenses for
the Windows Components, or you do not plan to use the Windows Components,
enter 0.

When you have finished, go to Step 12.

10 Provide your license file information by doing one of the following:

o

Import the information from the license file automatically by giving the path to
the .upd file. This is the file that AccountLink sends to an e-mail account when
you request a license. It has the filename format similar to license_for_server.upd.

Enter none to provide the license key information manually. You will need a
printout of the content of the .upd file. Follow the prompts to enter the
information.

11 Define the location for the license.dat file that will be created from the information
supplied by the license_for_server.upd file. By default, rs_install creates the
license.dat file and stores it in the rational_dir/config directory.

Choose either the default path (option 1) that rs_install has selected or choose
option 2 to specify an alternate path.

12 Proceed with the License Check Menu. Do one of the following:

o

If you are using an existing license, run through options 1 and 3. Note that
these options are the default settings provided by rs_install. There is no need to
restart the license server (option 2) if it is already running.

If you are using a permanent floating license, run through options 1-3
sequentially and forward to the next menu. If you are setting up a permanent
node-locked license, run through option 1 only. Note that these options are the
default settings provided by rs_install.

If you are using a Rational Suite (UNIX Components) temporary license, run
through option 1 and forward to the next menu. If you are using a Rational
Suite (Windows Components) temporary license, run through options 1-3
sequentially and forward to the next menu. Note that these options are the
default settings provided by rs_install.

13 The Product Customization Menu allows you to refine your Suite product
installation. The default settings for Rational Suite DevelopmentStudio RealTime
(Solaris) are shown in Figure 5. The default settings for Rational Suite
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DevelopmentStudio RealTime (HP-UX) are shown in Figure 6. To change the
installation setting between yes and no, enter the product number. Once you have
the settings you desire, enter f to forward to the next menu.

Note: To accommodate heterogeneous environments, the Product Customization
Menu gives you the ability to install Rational Unified Process (RUP) for IBM and
Microsoft environments on a UNIX server. The default installation settings install
the UNIX version of RUP (classic) but you may install any or all variants to
support existing clients running in IBM or Microsoft environments. To install other
versions of RUP, enter the corresponding number for the variant that you want to
install. To deselect the classic version of RUP, enter its number to change the
selection to no.

Note: Actual file sizes may vary from that shown in Figure 5 and Figure 6.

Figure 7 Product Customization Menu: Solaris (RealTime Edition)

Instal | ?Si ze (KB) Devel opnent St udi o Real Ti me 2002. 05. 00

9) yes 87170 Cl ear Quest Client 2002.05.00
10) vyes 13224 Cl ear Quest Oracl e Support 2002.05. 00

custom 693113 Tot al
+ This product is |icensed.

1) yes 15764 + Purify 2002.05. 00
2) yes 14374 + Quantify 2002.05. 00
3) yes 8735 + Pur eCoverage 2002. 05. 00
4) yes 308019 + Rational Rose Real Time for UNI X 2002. 05. 00
5) yes 53419 + Rational Unified Process (classic) 2002.05.00
6) no -- + Rational Unified Process (IBM 2002.05.00
7) no -- + Rational Unified Process (M crosoft) 2002.05.00
8) yes 192408 + SoDA 2002. 05. 00
+
+

b) Back to the previous nenu.

f) Forward to the next nenu to continue...

q) Quit rs_install. Enter q! to quite without saving your inputs.
?) Hel p.

Enter a product nunber (1-10) or range to (de)select.
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Figure 8 Product Customization Menu: HP-UX (RealTime Edition)

Instal | ?Si ze (KB) Devel opnent St udi o Real Ti ne 2002. 05. 00

1) yes 10289 + Purify (HP-UX) 2002.05.00
2) yes 11551 + Purify (HP-UX 64) 2002.05.00
3) yes 9687 + Quantify (HP-UX) 2002.05. 00
4) yes 11253 + Quantify (HP-UX 64) 2002.05.00
5) yes 11782 + PureCoverage (HP-UX) 2002.05. 00
6) yes 328545 + Rational Rose Real Time 2002 for UN X 2002.05. 00
7) yes 57137 + Rational Unified Process (classic) 2002.05.00
8) no -- + Rational Unified Process (IBM 2002.05.00
9) no -- + Rational Unified Process (M crosoft) 2002.05.00
10) vyes 250719 + SoDA 2002. 05. 00
11) yes 213147 + Cl earQuest Client 2002.05.00
12) yes 15298 + Cl ear Quest Oracle Support 2002.05.00
custom 1614606 Tot al
+ This product is |icensed.
b) Back to the previous nenu.
f) Forward to the next nenu to continue...
q) Quit rs_install. Enter q! to quite without saving your inputs.
?) Hel p.

Enter a product number (1-10) or range to (de)select.

14 The SoDA Product Configuration Menu allows you to customize your SoDa
installation. Options are summarized in the following table. Note that all options
install SODA demos and training files.

Option

Description

1

Choose this option if you want to integrate Rational SODA with Rational Rose
and Rational ClearQuest. This option applies to Rational Suite
DevelopmentStudio.

Note: To use this option, you need to have Rational Rose installed, either as a
point product or as part of the Rational Suite DevelopmentStudio edition of
Rational Suite.

Choose this option if you want to integrate Rational SODA with Rational Rose
RealTime and Rational ClearQuest. This option applies to Rational Suite
DevelopmentStudio RealTime.

Choose this option if you want to integrate Rational SODA with Rational Rose.
This option applies to Rational Suite DevelopmentStudio.

Note: To use this option, you need to have Rational Rose installed, either as a
point product or as part of the Rational Suite DevelopmentStudio edition of
Rational Suite.

Choose this option if you want to integrate Rational SODA with Rational Rose
RealTime. This option applies to Rational Suite DevelopmentStudio RealTime.
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5 Choose this option to install all Rational SoDA domains (Apex, Rose, Summit,
TestMate, ClearCase, ClearQuest, and Rose RealTime).

Note: To use this option, you need to have Rational Rose installed, either as a
point product or as part of the Rational Suite DevelopmentStudio edition of
Rational Suite.

15 The SoDA Product Component Customization Menu allows you to customize your
SoDA installation. To toggle the installation setting between yes and no, enter the
product number. After you have the settings you want, enter f to forward to the
next menu.

16 The Install Documentation Menu allows you to install online documentation for
Rational Purify, Quantify, and PureCoverage.

17 The Enter Install Mode menu allows you to decide whether you want rs_install to
prompt you before it reinstalls a product, skip a product if it is already installed on
your system, or reinstall the product without confirmation.

The installation process starts.

18 You are prompted to configure the cache directory for Rational Purify, Rational
PureCoverage, and Rational Quantify. Do one of the following:

o Enter no to accept the default directory.
o Enter yes to specify an alternate location and follow the prompts.
19 Are you configuring SoDA to work with Apex? Enter a value Yes or No.
If you chose Yes, you will need to provide the path to the Apex directory.
20 Enter the FrameMaker + SGML directory. Do one of the following:

o If you do not have FrameMaker + SGML installed on your system, enter none.
Continue with the installation and see Integrating Products That Are Not Part of
the Suite on page 77 after you have finished installing.

o If you have FrameMaker + SGML installed, enter the path.

Note: This release of SODA does not include FrameMaker + SGML. You need to
have either version 5.5 or 6.0 installed to use SoDA.

21 Use ClearQuest with SODA? Enter a value Yes or No.

If you choose Yes, you will be prompted to provide the path to the ClearQuest
installation. If you chose to install ClearQuest in Step 14, the default path is
rational_dir/releases/ClearQuestClient.2002.05.00. You can accept the default or
specify another path.
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22 Use RoseRT with SoDA? Enter a value Yes or No.

23 The Web Setup Menu allows you to enter the URLSs for a Requisite Web server or a
ClearQuest Web server. These applications run on a Windows server and can be
accessed by UNIX developers through a web browser. Do one of the following:

o If you do not plan to use these web interfaces, enter none.

o If you do not know the URL for these servers, enter none and run the
web_setup command after you have the URLs.

o If you know the URLSs, enter them now.

24 If you chose to install more than one Rational Unified Process variant in Step 14,
you are prompted to select which variant you wish to use as the primary. Enter an
option (1-3) to select the primary variant. The default setting is the UNIX (classic)
version of RUP.

Note: You may change the primary RUP variant at any time by running the
post_install command. For more information see Changing the Primary RUP Variant
on page 78.

The installation of the Rational Suite DevelopmentStudio RealTime is now complete.

Installing Rational Rose RealTime Companion Products

Rational Rose RealTime Professional Edition includes additional software that
extends Rational Rose RealTime to provide support for many embedded targets. The
following two products are provided on the Rational Rose Real Time Companion Products
CD:

Rational Connexis
Rational Quality Architect - RealTime Edition (RQA-RT)

For instructions on how to install the above products, see the Release Notes and
Installation Guide - Rational Rose RealTime Professional Edition. Before you can use
Rational Connexis, you must set the Connexis environment variable. This information
is provided in the Release Notes and Installation Guide - Rational Rose Real Time
Professional Edition.
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Installing the Online Documentation
Use the following procedure to install the online documentation.
To install the online documentation:
1 Log on to the install client. This may be any UNIX computer that:
o Gives you access to a CD-ROM drive
o Mounts the file system into which you will load the Rational Suite release

o Runs the operating system specified on the Rational Solutions for UNIX Online
Documentation CD (Solaris 2.6, Solaris 7, or Solaris 8; or HP-UX 10.20, 11.0, or
11.11)

Note: You do not need to be root to install the product.

2 Place the Rational Solutions for UNIX Online Documentation CD in the CD-ROM
drive.

If the CD-ROM drive is not mounted, supplemental instructions can be found in
the appendix, Accessing the CD-ROM Drive on page 145.

3 Run the installation script, rs_install, which is located at the root level of the CD.
.Irs_install

rs_install can be invoked with a number of options. For example, the -no_log (-nl)
option can be used to stop rs_install from creating a log file. To see a listing of all
available options, run rs_install -help.

4 The Install Documentation Menu allows you to refine your online documentation
installation. The default settings are shown in Figure 9.

To change the installation setting between yes and no, enter the product
documentation number. Once you have the settings you desire, enter f to forward
to the next menu.

Note: Actual file sizes may vary from that shown in Figure 9.
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Figure 9 Install Documentation Menu

Instal | ?Si ze (KB) Product Docunentation
1) yes 10830 Devel opnment Studi o for UNI X Docunents
2) yes 18009 Cl ear Quest Docunent s
3) yes 2714 Devel oper Tool s Docunents
4) yes 416 FLEXI m User Manual and FAQ
5) yes 5206 Requi sitePro Docunents
6) yes 13740 Rose Docunents
7) no 44751 Rose Real Ti ne Docunents
8) yes 243 RUP Docunent s
9) yes 1113 SoDA Docunent s
al | 97022 Total (does not account for docunments

al ready installed

a) Al'l of the above.

n) None of the above.

b) Back to the previous nenu.

f) Forward to the next nenu to continue...

q) Quit rs_install. Enter q! to quit wthout saving your inputs.
?) Hel p.

Enter a nunber (1-8) or range to select or de-select which docunments to
install.

5 The Tool Customization Menu allows to you install Netscape 4.7 and Adobe
Acrobat 4.0. The default setting is set to install both products.

If you choose to install the version of Netscape provided with Rational Suite, it is
configured so that Adobe Acrobat is automatically launched when you click a link
to a PDF file.

If you choose not to install the version of Netscape provided with Rational Suite,
you can access the PDF files with the Adobe Acrobat acroread executable. Also,
you should point your browser to the following location to access an HTML page
that contains links to all documents (HTML and PDF):

rational_dir/releases/DevelopmentStudioUNIX.2002.05.00/docs/index.html

Note: Netscape Navigator and Adobe Acrobat are installed in the
rational_dir/base/cots directory, where rational_dir is the installation path for the Suite.

6 The Enter Install Mode menu allows you to decide whether you want rs_install to
prompt you before it reinstalls a product, skip a product if it is already installed on
your system, or reinstall the product without confirmation.

The installation process starts.
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Verifying Your Installation

It is recommended that you verify that your installation is working properly. This test
ensures that both the installation and licensing are working. If you experience any
problems, refer to the Administering Licenses chapter on page 107, and the
Troubleshooting chapter on page 129.

Note that Rational Rose, SODA, and ClearQuest require configuration before actual
use. For configuration information, please see the Configuring Rational Rose for UNIX
on page 120, and the Configuring Rational SoODA on page 123 of this document. For
ClearQuest configuration, please see the ClearQuest Release Notes (HTML) and
Installing Rational ClearQuest (PDF) documents.

To verify your installation:

1 Test the UNIX installation and licensing by running Rose and SoDA.

For csh, tcsh, or compatible shells, do the following:

% source rational _dir/rs_setup.csh

% r ose

% soda

For ksh, bash, or other Korn-compatible shells, do the following:
$ . rational _dir/rs_setup. ksh

$ rose

$ soda

Note: rs_setup.csh and rs_setup.ksh are setup scripts. For additional information
on the setup script see “Running the User Setup Script” on page 76.

Running the User Setup Script

76

Installation creates two setup scripts which set up the environment to run all the
Rational Suite (UNIX Components). These can be used as a common logon for users,
and as a convenient point for additional customization.

For csh, tcsh, or compatible shells, source the following from the .cshrc file:
source rational _dir/rs_setup.csh

For sh, ksh, bash, and other Bourne-compatible shells, source the following from
the .profile file:

rational _dir/rs_setup. ksh
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Use the aliases summarized in the following table to start a Suite product:

Product

Start command

Rational Rose

%rose (to start Rose)
% nodel i nt (to start Rose Model Integrator)
% anal yzer (to start Rose C++ Analyzer)

Rational Rose RealTime

% RoseRT (to start Rose Real Ti ne)
% nodel i nt RT (to start Rose RealTime Model Integrator)
% anal yzer (to start Rose C++ Analyzer)

Rational PureCoverage
Rational Quantify

Rational SoDA for % soda
FrameMaker
Rational Purify % purify

% pur ecov
% quantify

See Installing and Getting Started: Rational Purify Plus, Rational
Purify, Rational PureCoverage, Rational Quantify for a full
description of start command options.

Rational ClearQuest

% cl ear quest

Rational Unified Process

% vi ew up_cl assic (for UNI X RUP)
% vi ewr up_i bm (for | BM RUP)
% viewup_nsft (for Mcrosoft RUP)

% viewup (starts the primary RUP)

Note: If you only chose to install one variant of RUP then you
may use the viewrup command to start it. You only need to use
the environment-specific commands if you have more than
one variant installed and that variant has not been defined as
the primary.

Integrating Products That Are Not Part of the Suite

You may choose to add products that are not part of the Suite after you have installed
Rational Suite. The following products are examples:

= Adobe FrameMaker + SGML 5.5 or 6.0 (required to use Rational SODA)

= Rational Apex

If you answered no to adding any of these products when you ran rs_install, you may
install them later and simply run post_install. The post_install command allows you to
run a subset of rs_install that includes prompts for integrating other products with

Rational Suite.
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Setting up Rational RequisiteWeb and Rational ClearQuest Web

If you have installed Rational RequisitePro on Windows, you can give UNIX users
access through their browser by pointing to the Rational RequisiteWeb Server.

If you have installed Rational ClearQuest on Windows, you can give UNIX users
access through their browser by pointing to the Rational ClearQuest Web Server.

Run the web_setup command to define the URLSs for the Rational RequisiteWeb and
Rational ClearQuest Web Servers. The web_setup command allows you to run a
subset of rs_install and includes the prompts for defining the location of these servers.
The server information is recorded in the rpweb and cqweb scripts.

Changing the Primary RUP Variant

After you have installed Rational Suite using rs_install, you can change the primary
RUP variant at any time by running the post_install command. This only applies if
you have installed more than one RUP variant.

Installing Rational Suite (Windows Components)

Rational Suite for UNIX includes several Windows products that you can install and
run using your Rational Suite DevelopmentStudio (Windows Components) or
Rational Suite DevelopmentStudio RealTime (Windows Components) license key.
This group of products is referred to as Windows Components and includes the
following point products:

= Rational RequisitePro

Rational ClearQuest

Rational TestManager

Rational Administrator (required for Rational TestManager)
= Web Server Components

o Rational RequisiteWeb

o Rational ClearQuest Web

Note: Unless otherwise specified, Rational Suite (Windows Components) is used to
refer to both Rational Suite DevelopmentStudio for UNIX (Windows Components)
and Rational Suite DevelopmentStudio RealTime for UNIX (Windows Components).
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Before you install the Rational Suite (Windows Components), review the following:

Are you using a single UNIX server to manage licenses for both the Rational Suite
(UNIX Components) and Rational Suite (Windows Components)?

You can go ahead and install the Rational Suite (Windows Components).

= Are you using a Windows server to manage licenses for the Rational Suite
(Windows Components)?

You must install the license server software on the Windows server before you
install the Rational Suite (Windows Components). See Installing the Rational License
Server Software on Windows on page 97.

Important: Back up any user files before starting this procedure. Backing up your data
prior to installing any new software should be a regular practice.

Note: You also need to remove any previous versions of Rational Suite (Windows
Components) from the target system. For more information, see Removing Rational
Suite (Windows Components) on page 83.

To install the Rational Suite (Windows Components):

1 Insert the Rational Solutions for Windows CD into the system’s CD-ROM drive.

The setup program should start automatically. If autorun is disabled on the
system, click Start > Run. Using the drive letter of the CD-ROM drive, enter
drive:\SETUP.EXE.

Note: If you plan to install the Rational Suite (Windows Components) on a system
that already has other Windows editions of Rational Suite, the Suite editions must
be the same version. You cannot have different versions of the Suite installed on
the same system.

2 Do one of the following:

o If you are using a Rational Suite DevelopmentStudio (Windows Components)
license key, from the drop-down list, click Rational Suite for UNIX (Windows
Components).

o If you are using a Rational Suite DevelopmentStudio Real Time (Windows
Components) license key, from the drop-down list, click Rational Suite
DevelopmentStudio RealTime for UNIX (Windows Components).

Warning: Failure to select the correct product will cause the licensing to fail and
the Windows products will be unusable.
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3 At the Setup Configuration screen, select Custom.

a Confirm that Rational ClearQuest, Rational RequisitePro, Rational TestManager,
and Web Server Components are selected.

b Click Next and continue through the installation wizard until complete.

Restart your system when prompted.

Setting Up The License

Before you can use any of the Rational Suite (Windows Components), you need to do
one of the following:

Point to a License Server. (This can be either a UNIX or a Windows system.)
= Import a license file.

Do this if you plan to use the Windows system as both a license server and
application server.

Enter your temporary or evaluation license key information.

Do this if you are waiting for your permanent license and you want to get started
right away, or if you are evaluating the product.

To set up your Rational Suite (Windows Components) license:

1 The Rational License Key Administrator (LKAD) should automatically start when
you restart your system. If not, click the LKAD Wizard button (the button with the
Wizard’s hat), or click Start > Programs > Rational Suite DevelopmentStudio for
UNIX > License Key Administrator.

2 Do one of the following:

o If you already have a license server configured, click Point to a Rational License
Server to get my licenses. Indicate whether you are using a single license server
or a redundant server setup. Enter the server’s hostname and port number
(optional). Click Finish.

o If you want to use this system as the license server, click Import a Rational
License File. Locate the license file (file with a .upd extension) and click Open.
Click Finish.

o If you want to get started before you receive your permanent license key, or if
you want to evaluate the product, choose Enter a Temporary or Evaluation
License Key. (You need your license key certificate to proceed.) Click Floating
for the License Key type. Click the appropriate product from the drop-down

80 Chapter 4 - Installing the Product



list: Rational Suite DevelopmentStudio for UNIX (Windows Components) Or
Rational Suite DevelopmentStudio RealTime for UNIX (Windows Components).
Enter the information provided by your license key certificate. Click Finish.

3 Check that your Rational Suite (Windows Components) are licensed correctly by
starting the products from the Start menu, Start > Program Files > Rational Suite
DevelopmentStudio for UNIX.

Configuring and Testing RequisiteWeb

If any Rational RequisiteWeb users are going to access RequisiteWeb through the
UNIX version of Netscape Navigator, you will have to do the steps outlined in the
Configuring for UNIX Navigator Access topic. After installation, that topic and other
configuration information can be found on your RequisitePro server at:

c:\Program Files\Rational\RequisitePro\reqweb\reqwebsetup.html

If the HTML documentation files were installed on the UNIX server, the same
information can be found at rational_dir/docs/html/reqweb_install/RequisiteWebInstall.html

To test Requisite Web:
1 Enter the rpweb command on the UNIX host.
% r pweb

rpweb will launch Netscape Navigator, and display the RequisiteWeb URL. If the
rpweb command fails, then try sourcing rational_dir/rs_setup.csh.

For csh, tcsh, or compatible shells:

% source rs_setup.csh

% r pweb

For sh, ksh, bash, and other Bourne-compatible shells:
$ . rs_setup.ksh

$ rpweb

Another method of testing RequisiteWeb is to invoke Netscape Navigator and
point it at the RequisiteWeb URL with the following command.

% netscape -install http://requisiteweb_url
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Installing Rational TestManager and UNIX Test Agent

After you install and license Rational TestManager, you need to install Rational Test
Agent on a UNIX system.

Note: The same version of Rational TestManager and Rational Test Agent must be
installed on the Local and Agent computers; otherwise, they will not work together.

The UNIX Test Agent is included on the Rational Test Agent CD. For instructions on
how to install the UNIX Test Agent, see "Installing Additional Software" in the
Rational Testing Products Installation Guide.

Rational Administrator

Before you can use Rational TestManager, you must first create a project in Rational
Administrator. For more information, see the Rational Testing Products Installation
Guide.

Crystal Reports

Crystal Reports can be used with Rational TestManager to customize or create new
report formats from the standard output generated by these two applications.

Crystal Reports is provided on the Crystal Reports Pro Edition CD. To install this
product, refer to instructions provided with the CD.

Removing the Rational Suite Software

After you have installed the latest version of Rational Suite, and after all users have
switched to using it, you can remove the old release to reclaim disk space.

Removing Rational Suite (UNIX Components)

Rational Suite includes an uninstall script in its config directory. You can uninstall an
earlier release of a product or Suite by running this script in the rational_dir directory.

Before you run uninstall, you must verify that your system startup file has a valid path
to the Rational license daemon. See The License Manager on page 108. Open this file
and search for the string Imgrd.

If the file contains the following pathname, it is correct:

rational _dir/base/cots/flexl mversion/platform

If the pathname does not look like this, you must change the path.
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If you have set up the Rose/ClearCase integration on the server running uninstall,
you will see a message regarding “rose” and “rose_unit” merge and compare
operations. The type manager (or managers) which manage these operations for
“rose” and “rose_units” will include links to this release in relation to the merge and
compare operations. The messages will include instructions describing how to correct
the merge and compare links that become obsolete after uninstalling this release.

With the valid path to the Rational Suite license daemon established, you are ready to
run uninstall. Running the script with no command line arguments causes it to display
the list of products in the releases directory. You will be prompted for the product or
Suite to uninstall. If there is only one product, you will be asked for confirmation
before the uninstall takes place. You must be the installer of the product to uninstall it.
If you select a Suite, you will be given a chance to review the products in the Suite that
would be uninstalled as part of the Suite uninstall. The default action will be to
remove all of the point-products and the Suite directory.

Example:

% cd rational _dir
% confi g/ uni nstal |

If you have installed more than one version of Rational Suite in the same rational_dir
directory, the uninstall program will only uninstall the products for a particular Suite
if that same product is not a member of another Suite. For example, if Suite 1.0
contains SODA 3.0.0c and Purify 4.4 and Suite 2.0 contains SoDA 3.0.1 and Purify 4.4,
Purify 4.4 is common to both, so it will not be uninstalled until both Suites have been
uninstalled. The license software will only be removed when the last Suite using it is
removed. In all cases, you can select one or more products in the Suite to be spared
from the uninstall operation.

Note: Manually removing the Suite directory does not remove the Suite. The only
things in the Suite directory are the Suite documentation, Suite installation tools and
Suite data.

Removing Rational Suite (Windows Components)
Use this procedure to remove the Rational Suite (Windows Components).
To remove Rational Suite (Windows Components):

1 Click Settings > Control Panel.

2 Double-click Add/Remove Programs.
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3 Do one of the following:

o To remove Rational Suite DevelopmentStudio for UNIX (Windows
Components), click Rational Suite DevelopmentStudio for UNIX and click
Add/Remove.

o To remove Rational Suite DevelopmentStudio RealTime for UNIX (Windows
Components), click Rational Suite DevelopmentStudio RealTime for UNIX and
click Add/Remove.

Note: Do not attempt to remove a product by just deleting program directories -
there are many registry entries that need to be modified as well.

If you have removed the Rational Suite (Windows Components) and plan to reinstall
the components or install a new version, we recommend that you reboot your system
after you have removed the software. Once you have rebooted, proceed with the
installation.

The Rational Software setup program may install Microsoft Shared components into
the Windows 9x System, and Windows NT System32 directories. These Microsoft
components are not removed when you remove the Rational Suite (Windows
Components). Other programs may use these files; therefore, following Microsoft
guidelines, we do not remove them from your system.

In addition, a minimal number of files will remain under the folder

<drive>:\Program Files\Rational\. This is intentional so that removing the software does
not delete any user files that you may have created while using the products. You can
manually delete these files if you want to remove them from your system. Do not
delete the entire \Program Files\Rational folder itself unless you are certain that you
have uninstalled all products installed from the Rational Solutions for Windows CD (or
other Rational product CDs).
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Next Steps

If you plan to set up a Windows license server to administer licenses for Requisite
Web, see Installing the Rational License Server Software on Windows on page 97.

= If you have Rational ClearCase installed and plan on using it with Rational Rose,
you need to set up the Rose/ClearCase integration by following the directions in
the Rose on-line help topic “Configuring the Rose for UNIX/ClearCase

Integration”.

If you plan to set up your UNIX license server in a redundant configuration, see
Setting up Redundant License Servers on UNIX on page 87.

= The applications listed in the following table must be configured before you can

use them:

Point Product

Action

Rational Rose

See After You Install chapter on page 117.

Rational SoDA for
FrameMaker

See After You Install chapter on page 117.

Rational Purify
Rational PureCoverage
Rational Quantify

See After You Install chapter on page 117.

Rational ClearQuest

See the Rational ClearQuest Installation Guide.
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Setting up Redundant
License Servers on UNIX

This chapter describes how to set up UNIX license servers in a fault-tolerant
configuration known as redundant servers. It includes the following topics:

Redundant Server Configuration on page 87
Installing the License Server Software on page 88
Setting Up the Redundant Server License Files on page 90
= Restarting FLEXIm When a Server Reboots on page 94
= Setting up Applications to Use Redundant Servers on page 95

Redundant Server Configuration

Redundant servers are a system of three servers that work as a team to manage a
single pool of floating license keys. If one of the server systems goes down, the other
two license servers automatically continue to manage the license pool. This type of
redundant configuration requires that a minimum of two license servers be running at
all times. If two servers go down, licenses will be unavailable until one of the servers
is restarted.

Warning: It is a common misconception that separating redundant servers across
multiple sites (for example, one in the U.S., one in Europe, and one in Asia)
provides maximum fault tolerance. This is not the case. Redundant server
partners should always be at the same site and on the same subnet.

Figure 10 shows the redundant server configuration.

A homogeneous redundant server setup is recommended (that is, all servers are
running the same operating system); however, heterogeneous environments are
supported. For example, you could have two license servers running Solaris and one
running HP-UX.
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Figure 10 Redundant Server Configuration

Primary Secondary Backup
(Solaris, HP-UX) (Solaris, HP-UX) (Solaris, HP-UX)

Note: A Windows license server is not a supported platform in a UNIX redundant
server setup.

Each license server must have its own copy of the license file and the license software
must be installed locally (NFS is not supported). Each server runs a FLEXIm Imgrd
process and a rational daemon process to manage licenses.

HTML versions of the FLEXIm User Guide and FLEXIm Frequently Asked Questions are
provided online in the /docs directory. To access these guides type rsdsu_help. The
FLEXIm Frequently Asked Questions includes important information about setting up
redundant servers.

Installing the License Server Software

You can install the FLEXIm license server software on all three servers without
installing the product using rs_install. In fact, if this is a first-time installation, this is
probably the best method. rs_install cannot import a redundant server license file
directly, so it is necessary to set up the license file as described in Setting Up the
Redundant Server License Files on page 90. The section Setting up Applications to Use
Redundant Servers on page 95 provides tips for running rs_install after you have set up
your redundant license servers.

If this is an existing installation and the license server software is already installed on
one system, go ahead and follow this procedure to install the license server software
on the secondary and backup machines. Complete all the tasks in this chapter and
refer to the section Setting up Applications to Use Redundant Servers on page 95 for
instructions on what to do next.
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To install the license server software:
1 Obtain copies of the FLEXIm license server software by doing one following:

a Locate the FLEXIm license server software on the Rational Solutions for UNIX
CD. The files are in the following location: extras/flexim/$SYS/7.0f.

b If you cannot find the FLEXIm tar file for the platform you need, you can go to
the following FTP site ftp://ftp.rational.com/public/tools/flexim and download it.
Occasionally, downloading the file causes the periods in the filename to be
replaced with underscores. If this happens, simply rename the file replacing the
underscores with periods.

Compressed tar file UNIX Vendor S;ig?:ng Version
flexim.7.0f.aix.tar.Z IBM AIX 4.x
flexIm.7.0f.hp.tar.Z HP HP-UX B.10.20, B.11.00
flexim.7.0f.sg32.tar.Z SGI IRIX 6.X
flexim.7.0f.sol.tar.Z Sun Solaris 2.X

Note: SunOS 4.x and IRIX 5.x are no longer supported by version 7.0f of
FLEXIm. As a result, these systems cannot be used as license servers.

2 Copy the FLEXIm files to the $FLEXROOT directory on all three servers. The term
SFLEXROOT is used herein to represent the location from which you plan to run
FLEXIm.

Note: If you downloaded the software from the FTP site, you will have to unpack
the files as shown in the example below.

Example using the HP-UX tar file:

cd $ROOT

dd if=flexIm7.0f.hp.tar.Z | unconpress | tar -xvf -

I's -1 flexI m7.0f/hppa_hpux (to verify that it got installed)
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If you get the following

error:

flexlm7.0f. hp.tar.Z: No such file or directory
stdin: not in conpressed fornmat

tar: No input

Make sure the input file (if=) flexim.7.0f.hp.tar.Z is in the local directory
($FLEXROOT).

Warning: Be sure to copy the appropriate tar file for the platform on which you are
installing.

Setting Up the Redundant Server License Files

The following is a high-level summary of the steps you need to perform to set up the
redundant server license files.

1 You need to get a license key for redundant UNIX servers. For more information,
see Licensing Requirements for Redundant Servers on page 90.

2 Place copies of the same license file on each of the three license servers and ensure
that the order of the SERVER lines is the same in each file. For more information,
see Renaming License Files on page 91.

3 Assign a TCP/IP port to each server. For more information see, Assigning TCP/IP
Ports on page 91.

Licensing Requirements for Redundant Servers

You need to have a license file for a redundant server setup before you can proceed.
You can verify this by opening the license file and checking for three server lines. If
you do not have a three-server license file, you will need to return your single server
license file and request a new redundant server license file.

1 Determine the host names for the machines that you plan to use as your primary,
secondary and backup servers.
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2 Go to AccountLink (http://www.rational.com/accountlink) and request a license for
redundant servers. Be sure to specify the redundant servers in the correct order:

o Host ID is the primary server
v Host Name #2 is the secondary server
o Host Name #3 is the backup server

Note: If you do not have an internet connection, see Requesting License Keys by Fax
on page 53.

Renaming License Files

The license file (license_for_primary.upd) needs to be copied to the $FLEXROOT
directory. You need to maintain this file on all three servers.

Copy and rename the file to rational.dat as shown below:

cp license_for_primary.upd $FLEXROOT/ rati onal . dat

Assigning TCP/IP Ports

You must assign a TCP/IP port number to each server by modifying the port
assignment in each SERVER line.

Warning: There is a known problem in FLEXIm that prevents redundant servers from
communicating with each other if you use the default port numbers: 27000
to 27009. Use a port number between 1501 and 26999. Ensure that the port
number you use is not in conflict with any other TCP/IP services.

To specify the TCP/IP port number:

1 Choose three port numbers between 1501 and 26999 to use for each server. Note
that the same port number can be used for each server, or the port numbers can be
unique.

2 Check that the port is not already in use. (Port 1706 is used in the sample
commands below.)

o Check the etc/services file
grep "[ ]1706/" /etc/services
o Check the NIS services by using the ypcat services command.

ypcat services | grep "[ ]1706/"
Note: There is a tab and a space character between the [].
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3 Edit the license file to use the new port numbers.
cd $FLEXROOT
vi rational.dat
Your license file should |ook sinmlar to the exanpl e bel ow
SERVER prinary 8001d410 1706
SERVER secondary 8001d625 1706
SERVER backup 8001d873 1706

Configuring and Starting the License Servers
You must do the following to start the license servers:

= You must configure the start script for each server. This is best done by copying a
template file and modifying it.

You must start each license server manually by using the start_Imgrd script.

Configuring the Start Script

Working from the $FLEXROOT directory, you need to create a start script for each
server. A template start script can be obtained at the following FTP site:
ftp://ftp.rational.com/public/tools/flexim/start_Imgrd

1 Copy the template file to the $FLEXROQOT directory on all three license servers.
2 You need to set the following four variables in the start_Imgrd script.

Solaris Example:

FLEXROOT=/ usr/rational /fl exI m 7. Of

LI CENSE_DI R=$FLEXROOT/ sun4_sol ari s2

LI CENSE_DAT=$FLEXROOT/ r at i onal . dat

LI CENSE_USER=j oe

HP-UX Example:

FLEXROOT=/ usr/rational /fl exl m 7. Of

LI CENSE_DI R=$FLEXROOT/ hppa_hpux

LI CENSE_DAT=$FLEXROOT/ r at i onal . dat

LI CENSE_USER=j oe

92 Chapter 5 - Setting up Redundant License Servers on UNIX



The above examples show FLEXIm being installed in the same location, using the
same license file name, and the same user. This helps simplify the setup and makes
it easier to maintain.

Starting License Servers

After you have completed the following, you are ready to start all three license
Sservers:

= You have installed the FLEXIm license server software on all three servers.

» You have copied the redundant server license file to the $SFLEXROOT directory on
all servers.

You have configured the start scripts for all servers.
The servers must be started in the correct order: primary, secondary and backup.
To start the license servers:
1 Start the primary server by entering the following commands:
cd /usr/rational /flexIm
.Istart_|I ngrd
2 Repeat Step 1 for the secondary and backup servers.
3 Check the status of each server:
.Istart_Ingrd Instat -a
To stop the license servers:
1 Stop each license server by entering the following command:
./start_Imgrd stop
To verify the license file:
1 Check the Rational INCREMENT line by running the exinstal command:
./start_Imgrd ex

This command will generate a report if the license file is not properly encrypted.

Problems starting the license server

If the license server will not start, check the corresponding Imgrd log file (specified by
LICENSE_LOG in start_Imgrd).

1 Error message: ulimit: bad ulimit

If you see this message when you run start_Imgrd, remove the ulimit command
from the script.
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2 If there are any other problems, check that the start scripts reference the correct
license file (LICENSE_DAT), the license directory (LICENSE_DIR), and the license
log file (LICENSE_LOG). Mail the start scripts, the license files, and the log files to
support@rational.com. For more information about contacting Rational Licensing
Support see Contacting Rational Licensing Technical Support on page xvii.

Restarting FLEXIm When a Server Reboots

All three license servers should be set up to be restarted at boot time. This is
accomplished by copying the start script to the appropriate system directory.

Note: For security reasons, it is recommended that you do not run Imgrd as root. It is
recommended that you run Imgrd as a user by setting the LICENSE_USER variable.
The user id that you specify, must exist on the system that runs the start script. In the
example below, the user is set to “joe”.

FLEXROOT=/ usr/rational /fl exl m 7. Of
LI CENSE_DI R=$FLEXROOT/ hppa_hpux

LI CENSE_DAT=$FLEXROOT/ r at i onal . dat
LI CENSE_USER=j oe

In previous releases, Rational used the filename SimRational.sh in the system start
directories. If there is an SiImRational.sh file under any of the /etc/ or /sbin directories
they should be removed and replaced with S98Rational.

The following sections provide the start script commands for each operating system.

Note: You must be root to perform these steps.

Sun Solaris
cd /usr/rational/flexlm

cp start_Ingrd /etc/rc2. d/ S98Rat i onal

If you need to remove a reference to the SImRational.sh file, use the following
command to do so:

/binfrm-f /etc/rc2.d/ Sl nRational.sh

HP-UX
cd /usr/rational/flexlm
cp start_Ingrd /sbin/init.d/ S98Rati onal
In -s /sbin/init.d/ S98Rational /sbhin/rc2.d/ S98Rati onal
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If you need to remove a reference to the SimRational.sh file, use the following
command to do so:

/binfrm-f /sbin/*.d/ Sl nRational.sh

SGI IRIX
cd /usr/rational/flexlm
cp start_Ingrd /etc/init.d/ S98Rati onal
In -s /etc/init.d/ S98Rational /etc/rc2.d/ S98Rati onal

If you need to remove a reference to the SimRational.sh file, use the following
command to do so:

/binfrm-f /etc/*.d/ Sl nRational.sh

IBM AIX

Edit /etc/inittab and add a line to run the start script using /bin/sh:
| ngr: 234: once:/bin/sh /usr/rational/flexlnmstart_|ngrd

Setting up Applications to Use Redundant Servers

This section explains how to set up your applications to use the new redundant
licenser server file.
Product is not installed

1 Install the product by running rs_install. For complete instructions, see Installing
the Product on page 55.

2 Choose option 1, use an existing FLEXIm license file, from the Licensing Options
Menu.

3 Enter the location of the license file (port@host) for all three license servers (for
example, 1706@primary:1706:secondary:1706:backup).

Product has been installed

1 Runthe command license_setup.

The license_setup command allows you to run a subset of rs_install that includes
setting up license options and running the license check sequence.

2 Choose option 1, use an existing FLEXIm license file, from the Licensing Options
Menu.
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3 Enter the location of the license file (port@host) for all three license servers (for
example, 1706@primary:1706:secondary:1706:backup).

4 Proceed with the License Check Menu. Choose options 3 and 4. You do not need to
run option 2 because you have already done this when you started the license
Servers.
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Installing the Rational
License Server Software
on Windows

This chapter describes how to use the Rational Software Setup program to install the
license server software on a Windows server, and includes the following topics:

Before You Install the License Server Software on page 97
Installing the Rational License Server Software on page 99
Using the Rational License Key Administrator (LKAD) on page 101
= Setting Up Licenses on page 102
= Starting the License Server on page 103
= Modifying the Floating License Time-Out Period on page 104
Removing FLEXIm License Server on page 106

You will need to copy your license file for Rational Suite for UNIX (Windows
Components) to the license server. If you do not have a license, see Requesting License
Keys chapter on page 51.

Before You Install the License Server Software

The following sections provide requirements for installing the license server.

Installation Requirements

Table 9 lists the system and software requirements for installing the Rational license
server software.
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Table 9 Rational License Server Requirements

Item Requirement

Operating System Microsoft Windows NT 4.0, Service Pack 2 or greater
Microsoft Windows 2000

The Windows systems must have a C drive.

On UNIX systems, the Rational license server is available
on all platforms that support Rational’s products.

Processor 133 MHz or greater

Memory 64 MB

Disk space 73 MB

Privileges Windows administrator privileges on the local system

Note: Make sure that you have a current backup of your Registry and system
directories before running the Rational Software Setup program.

Default Installation Path

The Rational Software Setup program uses C:\Program Files\Rational as the default
installation path. If your C:\ drive lacks sufficient free disk space, you may either
specify another drive or make space available on the default drive.

Note: Even though you are installing the software on a different drive, some space is
still required on C: drive to store shared system .dlls and portions of the License
Server Software.

Warning: Interrupting an installation that is in progress may leave your system in an
indeterminate state. If you try to close the Rational Software Setup window while
the installation is in progress, the Setup program asks you to confirm that you
want to exit from the incomplete installation.

Verifying Network Communication

1 Verify that the Windows application server is correctly networked to the license
server.

a Open acommand prompt window on the Windows application server, and
then ping both the license server IP address and the license server host name.

c:\>pi ng host nane
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c:\>ping | P_address
Note: The license server may be either a UNIX or Windows computer
depending on the licensing option you selected earlier.

If either ping fails, then the networking between the license server and the
application server must be corrected. It is beyond the scope of this manual to
describe configuration of the Windows network. If necessary, consult your
system administrator.

b From the exec client computer, ping the Windows application server.

% pi ng server_nane

Installing the Rational License Server Software

Use this procedure to install the Rational license server software.

To install the Rational License Server software:

1

Insert one of the Rational Solutions for Windows Discs into your system’s CD-ROM
drive.

The Rational Software Setup program starts automatically.

If autorun is disabled on your system, click Start > Run and enter
drive:\Setup.exe where drive is the letter of the CD-ROM drive.

The Rational Software Setup dialog box provides general information about the
software installation.

On the Choose Product dialog box, choose Rational License Server.

Choose to accept or not accept the Rational Software license agreement in the
License Agreement dialog box.

o If you accept the license agreement, the Setup program continues.

o If you do not accept the license agreement, you cannot continue with the Setup
program. Exit the Setup program by clicking Finish or Cancel. The Setup
program exits and makes no changes to the system.

The Select Configuration dialog box displays the setup options for the software.
The only choice available for the license server is Typical.

The Upgrade Compatibility dialog box appears if you have earlier versions of
Rational products already installed on the system. When you have earlier versions
of Rational products installed on your system, ensure that all Rational products on
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that system are upgraded to the same version. Because Rational tools share files
and components, a new installation can cause the older Rational products to stop
working.

For each of the Rational products listed in the Upgrade Compatibility dialog box, we
strongly recommend that you do one of the following:

o Upgrade it: Complete the installation, and then restart the Setup program to
upgrade the earlier versions of Rational products. For example, if you have
stand-alone installations of Rational point products on your system, upgrade
each product. If you have a Rational Suite and a point product on the same
system, upgrade both Rational products to the same version. Upgrading each
product updates all necessary files, registry entries, startup menu items, and
shared components on your system.

o Remove it: Complete this installation, and then see the Rational Suite Installation
Guide (Windows) for the removal procedure.

7 The Confirmation dialog box displays the product features that will be installed.

8 The Error Summary dialog box displays errors from the first part of the Setup
program. If the installation is successful, you do not see this dialog box.

The Rational Software Setup program writes a log of installation activities. The log
file is located in rational_dir\Rational\RSSetup\RSsetup.log.

Possible Reboot Required

If files required for the installation are in use during the Rational Software Setup
program, and if the program needs to install shared components on your system, the
Setup program may need to reboot your system. After rebooting, do the following:

1 Log on as the same administrator to complete the installation procedure. If you do
not log on as the same administrator, the installation does not complete correctly.

The installation process completes on your system.
2 Click Finish.

Note: Install the floating license keys on the license server before you start the license
server.
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Using the Rational License Key Administrator (LKAD)

The Rational License Key Administrator (LKAD) is installed with your Rational
software and with your Rational license server software. This Rational program
provides an interface to Rational Common Licensing features. Use the LKAD to enter
or import license keys and change your license configuration.

To access the LKAD on a client system, click Start > Programs > Rational product
name > Rational License Key Administrator.

To access the LKAD on a license server system, click Start > Programs > Rational
License Server > Rational License Key Administrator.

The Help explains how to use the LKAD to review and modify your license
configuration. The LKAD Help also provides information about configuring the
license server software. To access the Help, click Help in the License Key
Administrator’s main menu or open rational_dir\Rational\Common\licadmin.hlp.

Using the LKAD During the Rational Software Setup Program

To take care of licensing tasks before you install a product, open the Rational License
Key Administrator from the Rational Software Setup program. The Rational Software
Setup offers a Configure Licenses button in the Choose Product dialog box. When you see
the License Key Administrator appear, import a node-locked license key, enter an
evaluation license key, and specify a license server. After you configure product
licensing, return to the Rational Software Setup program and install the product.

Reviewing Your License Information in the LKAD

By default, you should see complete information about your license keys in the main
window of the License Key Administrator. If you do not see this information in the
window, use the View > Show menu to display information about your licenses.

Table 10 defines each of the options in the View > Show menu.

Table 10 Show Licenses

License Shows

Invalid and Expired Licenses | All expired node-locked, floating, and served licenses
on the system that you are using

Floating Licenses All floating licenses on the system that you are using
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Table 10 Show Licenses (continued)

License Shows

Node Locked Licenses All node-locked licenses on the system that you are
using

Served Licenses All floating licenses that Rational software on your
system could request from the license server

Setting Up Licenses

This section describes how to install permanent or evaluation license keys on the
Rational license server.

Importing Permanent or Term License Agreement (TLA) License Keys

Import the permanent license key file on the license server by using the Rational
License Key Administrator (LKAD).

To import a license key file:

1

2

Select License > Import License Key(s) on the menu bar.

In the Import License Key(s) dialog box, find the .upd or .txt file (license key file)
and highlight it.

Click Open. The default location for the license key file is
rational_dir\Rational\common.

The Restart License Server dialog box will ask you whether you want to restart the
license server. Stop and restart the license server to make the latest license key
available for license requests.

Other Methods

If your e-mail program supports launching programs from file attachments,
double-click the .upd or .txt attachment in the e-mail notification you received
from Rational Software. Select Open it in the Opening Mail Attachment dialog box.
Click the Import button in the Confirm Import dialog box.

Save the file attachment to any folder and double-click the license file.

Entering Temporary or Evaluation License Keys

You may enter a temporary or evaluation license key on the license server if you are
evaluating the product or AccountLink is unavailable.
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The temporary or evaluation license key information, including the expiration date, is
on your License Key Certificate. The License Key Certificate is enclosed in a large
green envelope in your Rational Software product shipment.

Enter the temporary license key information on the license server by using the
Rational License Key Administrator (LKAD).

= To open the LKAD during the Rational Software Setup program (before you install
the product), click Configure Licenses in the Choose Product to Install dialog box.
The License Key Administrator main window and the License Key Administrator
Wizard dialog box appear.

= To open the LKAD after you have installed the Rational product, click Start >
Programs > Rational product name > Rational License Key Administrator. The
License Key Administrator main window and the License Key Administrator
Wizard dialog box appear.

To enter temporary license information:
1 Select License > Enter a License in the menu bar of the License Key Administrator.

2 Choose the type of license you are installing: a Node-Locked License Key or a
Floating License Key.

3 Inthe next dialog box, enter the following information from your License Key
Certificate:

o Product

o Expiration Date

o License Key

o Quantity (if you are installing a floating license key)

4 Click Finish. The License Key Administrator creates a *. dat file for the license key
in rational_dir\Rational\common.

Starting the License Server

Start the Rational license server after you have imported or entered the floating
license keys.

Note: The Rational license server will not start until floating license keys are installed.
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Starting the License Server on Windows 2000

1 Click Start and select Settings > Control Panel > Administrative Tools > Services >
FLEXIm License Manager.

2 In the General tab, click the Start button under Service Status.

Starting the License Server on Windows NT
1 Click Start and select Settings > Control Panel > Services.

2 Select the FLEXIm License Manager in the Services dialog box and click the Start
button.

Note: Although the control panel applet may still appear on your system from an
earlier release of Rational server software, version 2001 does not use the FLEXIm
control panel applet.

Switching to Manual Startup

The Rational license server software is automatically set as a Windows NT service.
The default Startup type is automatic, which means the license server starts
automatically each time you start the system. If you prefer to manually start the
license server, switch the startup type.

Switching Startup Type on Windows 2000

1 Click Start and select Settings > Control Panel > Administrative Tools > Services >
FLEXIm License Manager.

2 Inthe General tab, select manual under Startup type.

Switching Startup Type on Windows NT

1 Click Start and select Settings > Control Panel > Services > FLEXIm License
Manager.

2 Inthe dialog box, select manual under Startup type.

Modifying the Floating License Time-Out Period

The Rational license server will reclaim a floating license when the product has not
been used for a default period of 120 minutes. If you use the product again after the
server has reclaimed its license, the product will check out the license again from the
server.
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To change the time-out period, create a text file called rational.opt in the <rational flexim
dir>\common directory. Enter one of the following two commands in the text file:

1 TIMEQUT f eat ure seconds directs the license server to reclaim the f eat ur e
(the product as it is listed in your license key file) after the number of seconds that
you enter into the file.

2 TI MEQUTALL seconds directs the license server to reclaim all products after the
number of seconds that you enter into the file.

The value for each of these options must be greater than 7200 seconds (or 120
minutes).

Note: You can edit the options file while the license server is running, but stop and
restart the license server after you have edited the file. See Starting the License Server on
page 103 for the Stop and Start buttons.

Modifying the Time-Out Period to Stop Disconnected Mode

The disconnected mode lets you use Rational software at home within a 3 day period
of acquiring a license key and disconnecting from the network at work. However, if
you have a slow network at work, your software automatically goes into disconnected
use mode if it does not receive a response from the Rational license server within 5
seconds. You then see a dialog box that states you are in disconnected use mode after
the 5 seconds.

Starting with release 2001A, you can change the time-out period before your Rational
application goes into disconnected use mode. The default setting is 5 seconds. To
change the setting:

1 Create a DWORD key: HKEY_LOCAL_MACHINE\SOFTWARE\Rational
Software\Licensing\1.0\DisconnectTimeout

2 Modify the value (decimal) to be larger than 5 seconds.
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Removing FLEXIm License Server

This section describes how to remove the license server software from the system.

Before You Remove the License Server Software

1 Make sure that no one is using the license server or any associated files. You
cannot remove files that are in use.

2 Return the license keys to your Rational Account through AccountLink
(www.rational.com/accountlink), the online license management tool. For more
information about moving or returning licenses, see Returning License Keys on
page 49.

3 To remove the software from a Windows NT system, you must have Windows NT
administrator privileges on the local system.

Removing the License Server Software

Use the Windows Add/Remove Programs control panel to select and remove the
license server software. The Rational Software Setup program removes the files from
your system. It does not remove directories that contain files that you created while
you were using the software. It also does not remove the license key files from the
system.
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Administering Licenses

This chapter describes the following topics related to Rational software licensing
services:

How Licenses Work on page 107
The License Manager on page 108
License Manager Commands on page 109
= The License File on page 110
= Customizing License Usage Order on page 110
= Licensing Diagnostic Messages on page 115
Frequently Asked Questions on page 115
FLEXIm User Guide and FAQ on page 116

How Licenses Work

Licenses are managed by a license manager (FLEXIm™ software delivered as part of
Rational Suite) that runs on a license server. The license manager monitors license
access, simultaneous usage, idle time, and so on.

When you start any Rational Suite point product, you are initially unlicensed. If a
license is available, the license manager gives you a Suite license, which allows you to
run any of the point products included in the Suite. You retain the license as long as
you keep using any of the products. When you exit the last program in the Suite, your
license is returned to the license manager and is made available for another user.

If a Suite license is unavailable, you are unable to use any of the products in the Suite
until a license is returned by another user.

Note: Rational ClearCase LT licenses are managed differently from other point
products. Rational ClearCase LT uses a linger feature that requires a user to claim a
license in increments of 30 minutes. After 30 minutes has elapsed, the license is
returned and made available to other users.
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The License Manager

Rational Suite uses the Flexible License Manager (FLEXIm™), version 7.0f, from
Globetrotter Software, Inc. The license manager includes the following components:

= A vendor daemon named rational that dispenses Rational Suite licenses.

The rational daemon is used for all of Rational’s licensed products. If you have
other products from other vendors that also use FLEXIm, they will include their
own vendor daemons.

A license daemon named Imgrd.

The same license daemon is used by all licensed products from all vendors that use
FLEXIm. The Imgrd daemon does not process requests on its own, but forwards
requests to the appropriate vendor daemon.

A license file that you maintain.

The license file specifies your license servers, vendor daemons, and product
licenses.

Note: Rational recommends that you use a single combined license file for all of your
Rational products.

After the license file is in place and the license daemons are running, the server
system needs to be set up to automatically restart the license server when it reboots.
The rs_install and license_setup scripts cannot do this automatically for you because
this action requires root permissions. The following sections provide the start script
commands for each operating system.

Sun Solaris
$ su

# cp rational _dir/config/start_| mgrd_on_server-name \
/etc/rc2.d/ S98Rat i onal

HP-UX

% su

# cp rational _dir/config/start_| ngrd_on_server-nanme \
/sbin/init.d/ S98Rati onal

# In -s /sbhin/init.d/ S98Rati onal /shin/rc2.d/ S98Rati onal
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License Manager Commands

To verify that your license manager is operational, you can enter these commands on
your license server to see if its daemons are running:

% ps axw | grep -v grep | egrep “lnmgrd|rational”
or
%ps -e | grep -v grep | egrep “Ingrd|rational”
The output should include lines similar to the following (your path names may vary):

538 ?? S 0:03.50 /rational/base/cots/flexIm7.0f/platform | ngrd
-c /rational/config/servernane. dat
-1 /rational/config/servernane.|og

539 ?? | 0:00.90 rational -T brazil 6.0 3 -c ...

Table 11 summarizes the system-administration commands that the license manager
provides.

Table 11  License Manager Commands

Command Description

Imdiag Allows you to diaghose problems when you cannot check out a license.
Imdown Shuts down license and vendor daemons

Imhostid Reports license manager host ID of workstation

Imreread Rereads license file, starts new vendor daemons

Imstat Reports status on daemons and feature usage

exinstal Reports on licenses in license file you specify on the command line.

For more information about these commands, you can view the FLEXIm online
documentation in the rational_dir/docs/html/FLEXIm_End-User_Manual directory. This
documentation is provided in HTML. These commands are documented in the License
Administration Tools chapter.
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Additional Licensing Commands

In addition to using the commands in Table 11, you can also use the license_check
command to run the FLEXIm Imstat command for counted licenses and the exinstal
command for any license file (not port@host). The Imstat command queries the license
server for a list of licenses that are in the license pool. The exinstal command checks
the license file format and license codes to see if everything is consistent.

The License File

The default Rational license file is either:
rational_dir/config/server-name.dat

or

rational_dir/config/Temporary.dat

The Temporary.dat file is used for both startup and evaluation licenses while the
server-name.dat file is used for permanent and TLA licenses.

When users start Rational Suite, the environment variable LM_LICENSE_FILE is
automatically defined for them. FLEXIm uses this variable to locate the license file.
The LM_LICENSE_FILE environment variable can contain non-Rational products but
Rational recommends that you keep the licenses in separate files.

Format

The license file is a text file that is set up by the rs_install or license_setup programs.
Your license file will contain a SERVER line, a VENDOR line and one or more
INCREMENT or FEATURE lines.

Detailed information about the license file and licensing can be found in the FLEXIm
End User Manual. To access this guide type rsdsu_help.

Customizing License Usage Order

It is possible to set up a mixed environment where the same license server manages
licenses for both a Suite product and individual point products. In this situation,
license usage order can be customized by modifying the settings in the License_Map
file on a per-component-product basis. For example, when a user starts an
application, such as Rational Rose, you can define whether that user claims a Rational
Rose license or a Rational Suite license.
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The License Map File

When you install Rational Suite, a default file called License_Map is created and
stored in the rational_dir/config subdirectory. Figure 11 shows the contents of the default
License_Map file for Rational Suite. The default License_Map file is set to claim a
Rational Suite DevelopmentStudio license for all products first. If that fails, it will
attempt to check out a Rational Suite DevelopmentStudio RealTime license followed
by a standalone license.

Figure 11 Default License Map File

purecov: 5. 0 Devel opnent St udi oUNI X: 1. 0, Devel opnent St udi oUNI XRT: 1. 0, st andal one
purify:5.0 Devel opnment St udi oUNI X: 1. 0, Devel opnent St udi oUNI XRT: 1. 0, st andal one
quantify:5.0 Devel opnent St udi oUNI X: 1. 0, Devel opnent St udi oUNI XRT: 1. 0, standal one
Rose98_Uni x: 6. 0 Devel opnent St udi oUNI X: 1. 0, st andal one

RoseReal Ti nme: 6. 0Devel opnent St udi oUNI XRT: 1. 0, standal one

Cl ear Quest: 1.1 Devel oprment St udi oUNI X: 1. 0, Devel oprent St udi oUNI XRT: 1. 0, standal one
soda: 3. 0 Devel opnent St udi oUNI X: 1. 0, Devel opnent St udi oUNI XRT: 1. 0, st andal one

Rat i onal Uni fi edProcess: 1. 0 Devel opnent St udi oUNI X: 1. 0, Devel opnent St udi oUNI XRT: 1. 0,
st andal one

Cl ear Case_LT: 1. 0 Devel opnent St udi oUNI X: 1. 0, Devel opnent St udi oUNI XRT: 1. 0, standal one

The License_Map file ‘maps’ a component product feature and version to a list of
features and versions to try in the order given. It contains lines of the following
format:

conponent _desi gnat or product _desi gnator {, product_desi gnator}
The component_designator is followed by a comma-separated list of
product_designators.

A component_designator specifies the FLEXIm feature and version number
associated with a given Suite component product and has the following syntax:
f eature_name: versi on_nunber (for exanple, purecov:5.0)

A product_designator specifies a FLEXIm feature and version number that the license
client subsystem will try to claim on behalf of the component product when that
product requests a license for the feature and version specified by the
component_designator. A product_designator has the following syntax:

f eat ure_name: ver si on_nunber (for exanple, Devel opnent St udi oUNI X: 1. 0)

In addition, the keyword "standalone" in place of a product_designator denotes a
stand-alone license; it is equivalent to specifying a product_designator that is identical
to the component_designator.
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Comments introduced by “#” are allowed anywhere in the map file.

Note: If a component product is not named in the license map file, then it defaults to
claiming a stand-alone license.

The following are some examples of license map settings and a description of how
they are handled.

Example 1

soda: 3. 0 Devel opnent St udi oUNI X: 1. 0, Devel opnent St udi oUNI XRT: 1. 0,
standal one # (Suite first)

This line tells SODA’s license client subsystem to first attempt to check out a Rational
Suite DevelopmentStudio license. If that fails, it will attempt to check out a Rational
Suite DevelopmentStudio RealTime license. If a Suite license is unavailable, the client
subsystem will attempt to check out a stand-alone license (that is, a license with
feature name soda and version 3.0 or greater).

Example 2
soda: 3. 0 standal one # (standal one only)

This line tells SODA’s license client subsystem to check out a standalone license only
(that is, a license with feature name soda and version 3.0 or greater).

Example 3
soda: 3. 0 Devel oprment St udi oUNI XRT: 1.0 # (Suite only)

This line tells SODA’s license client subsystem to check out a Rational Suite
DevelopmentStudio RealTime license only.

Note: You must have a license map file somewhere for Suite licenses to take effect. If a
Suite component product cannot find any license map file containing its component
name, it assumes that it is a stand-alone installation, that is, it will only try to check
out stand-alone licenses (and will fail if none are available). The only way for a
product to know that it is supposed to try a Suite license is if it finds that Suite license
feature name and version in a component mapping specified in a license map file.

RSU_LICENSE_MAP

When you run the user setup script (rs_setup.csh or rs_setup.ksh), the setup script
checks to see if the environment RSU_LICENSE_MAP variable is set. If the variable is
not set, the setup script sets the pathname to the default license map file (for example,
rational_dir/config/License_Map).
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Customizing License Usage for All Users

You can create a global license map file that applies to all users by copying the default
license map file and modifying it to suit your purposes.

To create a global License_Map file:
1 Copy the License_Map file (rational_dir/config/License_Map) to another location.
2 Modify the file by doing the following:

o To change the file to use a stand-alone license for the product first and a Suite
license second, edit the component as shown in the following example:

Rose98_Uni x: 6. 0 st andal one, Devel oprent St udi oUNI X: 1. 0

o To change the file to use a Suite license for the product first and a stand-alone
license second, edit the component as shown in the following example:

Rose98_Uni x: 6. 0 Devel oprent St udi oUNI X: 1. 0, st andal one

o To change the file to use only a Suite license for the product, edit the component
as shown in the following example:

Rose98_Uni x: 6. 0 Devel oprent St udi oUNI X: 1. 0

Note: You may choose to omit product designators that do not apply. For example,
if you have not installed Rational Suite DevelopmentStudio RealTime, you can
delete the entry “DevelopmentStudioUNIXRT:1.0.”

3 Instruct users to set the RSU_LICENSE_MAP variable to the pathname of your
customized license map file.

Customizing License Usage for Individual Users

You can customize license usage for an individual user by creating a license map file
for that particular user. The contents of the user license map file will override the
contents of the default or global license map file.

To create a customized License_Map file for individual users:
1 If the directory does not already exist, create a ~/.Rational directory.

2 Copy the License_Map to the ~/.Rational directory. If you are using a customized
global license map file, be sure to copy that version to the user’s directory and not
the default license map file in the config directory.

3 Only add the component lines for mappings that you want to override;

v To change the file to use a stand-alone license for the product first and a Suite
license second, edit the component as shown in the following example:

Rose98_Uni x: 6. 0 st andal one, Devel oprment St udi oUNI X: 1. 0
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o

o

o

To change the file to use a Suite license for the product first and a stand-alone
license second, edit the component as shown in the following example:

Rose98_Uni x: 6. 0 Devel opnent St udi oUNI X: 1. 0, st andal one

To change the file to use only a Suite license for the product, edit the component
as shown in the following example:

Rose98_Uni x: 6. 0 Devel opnent St udi oUNI X: 1. 0

To change the file to use only a stand-alone license for the product, edit the
component as shown in the following example:

Rose98_Uni x: 6. 0 st andal one

Note: You may choose to omit product designators that do not apply. For example,
if you have not installed Rational Suite DevelopmentStudio RealTime, you can
delete the entry “DevelopmentStudioUNIXRT:1.0.”

License Server Process

When you run a Rational Suite product, the following occurs:

1 The product checks to see if the environment variable RSU_LICENSE_MAP is set.
If it is set, it reads the license map file to which it points.

2

The product checks to see if a License_Map file exists in the user’s home directory (
~/.Rational/License_Map). If this file exists, its contents are read and override those
of the License_Map file read from $RSU_LICENSE_MAP as follows:

o

If a component_designator appears only in the $RSU_LICENSE_MAP file, then
it remains in force.

If a component_designator appears in both $RSU_LICENSE_MAP and
~/.Rational/License_Map, the mapping specified in $RSU_LICENSE_MAP is
replaced by the mapping specified in ~/.Rational/License_Map.

Considerations for Customizing License Usage

Because there is no “one size fits all” solution, it is worthwhile to consider the
following scenarios when defining your license map settings, especially settings that
affect all users.

Scenario 1: Rational Rose RealTime set to claim a Suite license first

RoseReal Ti ne: 6. 0 Devel oprent St udi oUNI XRT: 1. 0, st andal one

In this scenario, starting Rose RealTime will consume a Suite license making it
unavailable to other users. If the user is unlikely to use other Suite products, you may
want to make a standalone license the default.
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Scenario 2: Rational Rose RealTime set to claim a stand-alone license first
RoseReal Ti ne: 6. 0 st andal one, Devel opnent St udi oUNI XRT: 1. 0

If Rose RealTime always tries to check out a stand-alone Rose Real Time license before
attempting to check out a Suite license, another problem is introduced. Now, when the
user starts Rose RealTime, a Rose Real Time license is consumed, if one is available.
Later, if the user starts another Suite product such as SODA while their Rose RealTime
session is still active, SODA will check out a Suite license (assuming there are no
stand-alone SoDA licenses). At this point, the user is holding two licenses, a Rose
RealTime stand-alone license and a Suite license, where the Suite license alone would
have sufficed to run both Rose Real Time and SoDA.

It is important to take the time to think about usage profiles. For example, you need to
take into account what products users need and how frequently they use them. You
need to modify your license map files to best serve these usage profiles.

Licensing Diagnostic Messages

Setting the environment variable RSU_LICENSE_DIAG causes the licensing client
subsystem to generate diagnostic messages that show you what it is doing when it
searches for license map files, reads them in, and performs licensing operations. Since
license maps can be found in various places that depend on the user’s environment,
licensing operations can have unexpected results if you are not careful. In these cases,
it is very helpful to set RSU_LICENSE_DIAG and examine the resulting messages.

The default for Rational products is to print licensing diagnostic messages on
standard error. Note that Rational SODA does not do this.

Frequently Asked Questions

1 Can | use the FLEXIm licensing software that | already have installed?

Yes. Install our license code in the default location (in rational_dir/base/cots) and
use it to serve the Rational licenses.

2 lalready have FLEXIm installed and managing non-Rational licenses, and now |
want to install Rational Suite. Can | do this?

Yes. You can have more than one Imgrd on a system, but they must use different
ports. You can only have one rational daemon on the system.
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a What do | do if my existing FLEXIm installation uses port 27000?

27000 is the default port, so you need to specify a different port number for
Rational Suite. Do this by editing the license import file (.upd file) and
modifying the SERVER line. Change the port number to something other than
27000 (for example, 2001). Note that the port number follows the host ID.

b What do I do if my existing FLEXIm installation uses a port other than 27000?

You do not have to do anything since rs_install will default to port 27000. If you
are using the same server for other Rational products, you must specify the
port number you are using.

3 lalready have Apex installed with FLEXIm serving Apex licenses. What do | need
to do to install Rational Suite?

For Rational Suite version 2001A.04.00 and higher, you need to use a different
system as the license server. Do not use rs_install or license_setup. After the
licenses are received, append the Rational Suite license to the existing license file.
Reread the license file on the server by using the Imreread command.

As an alternative, you could use rs_install to set up Suite licenses and then
manually merge the Apex licenses into this file. If you point rs_install at an existing
license file with Apex licenses, the file will get saved to license_file.priorN, where N
starts at 1 and counts up to the next available prior file. The installer can then take
the licenses in that file and merge them back in. Releases after and including
Rational Suite, version 1.1 perform this merge automatically.

4 Can | use the FLEXIm redundant license server feature?

Yes. For more information, see Setting up Redundant License Servers on UNIX on
page 87.

FLEXIm User Guide and FAQ

HTML versions of the FLEXIm User Guide and FLEXIm Frequently Asked Questions are
provided online. If the online documentation is installed, you can access these guides
by typing rsdsu_help.

For technical support regarding licensing issues, use the contact information provided
in Contacting Rational Licensing Technical Support on page xvii as your first point of
contact.
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After You Install

This chapter provides an overview of tasks that you must perform after you have
installed Rational Suite. The following topics are included:

Configuring Rational Purify, PureCoverage, and Quantify on page 117
Configuring Rational Rose for UNIX on page 120
Configuring Rational SoDA on page 123

Configuring Rational Purify, PureCoverage, and Quantify

This section explains how to configure Rational Purify, PureCoverage, and Quantify
after you have installed the three products.

The configuration tasks include:
= Installing on a Read-Only File System on page 117
= Making the Manual Pages Available on page 118
Making the Product Available to All Users on page 119, including:
o Making Rational Quantify Scripts Available on page 119
o Making Rational PureCoverage Scripts Available on page 119
o Making Debugger Scripts Available on HP-UX on page 119

Installing on a Read-Only File System

If you install Rational Purify, PureCoverage, or Quantify on a file system that is
mounted read-only by client systems, you must create symbolic links to a writable file
system. The rs_install program guides you through the process of selecting a shared
directory that is mounted read-write on client systems and linking the cache directory
to this publicly writable directory.
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When There is No Writable File System

If there is no writable shared directory mounted on client systems, have all users
make a cache subdirectory in their home directory and set the product’s -cache-dir
option to this directory. For example

% nkdi r $HOVE/ cache
% echo $PURECPTI ONS

If the PUREOPTIONS environment variable is already set, specify the -cache-dir
option using one of the methods below.

For csh, tcsh, or compatible shells, do the following:

% set env. PUREOPTI ONS " - cache- di r =$HOVE/ cache: $PUREOPTI ONS"
For ksh, bash, or other Korn-compatible shells, do the following:

$ PUREOPTI ONS="- cache- di r =$HOVE/ cache $PURECPTI ONS"; \ export
PUREGPTI ONS

If the PUREOPTIONS environment variable is not set, define it using one of the
methods below.

For csh, tcsh, or compatible shells, do the following:

% set env. PUREOPTI ONS " - cache- di r =$HOVE/ cache"
For ksh, bash, or other Korn-compatible shells, do the following:
$ PUREOPTI ONS="- cache- di r =$HOVE/ cache"; export PUREOPTI ONS

Add this same specification to your local or central .cshrc file, or its equivalent.

Making the Manual Pages Available

The rs_install program installs the product manual pages in producthome/man. To make
them available, do one of the following:

Set your MANPATH environment variable to include producthome/man (where
producthome is one of purify, quantify, or purecov).

= Copy the manual pages for the product into your man directory. If necessary, log in
as root to do this.

*  Runningrs_setup.csh or rs_setup.ksh adds the locations of these product’s manual
pages to the MANPATH environment variable automatically.
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Making the Product Available to All Users

To make Rational Purify, PureCoverage, and Quantify available to all users, create a
symbolic link to producthome/product (where producthome is one of purify, quantify, or
purecov) from a directory such as /usr/local/bin. Make sure this is a symbolic link, not a
copy or a hard link.

For example:

% rm/usr/local/bin/purify

% In -s producthonme/purify /usr/local/bin

Repeat this procedure for each product you install.

Note: As an alternative, you can add the producthome/product pathname to each user’s
PATH environment variable, or reference the full path name in your makefile
(rs_setup.csh and rs_setup.ksh will do this for you).

Making Rational Quantify Scripts Available

To make Rational Quantify scripts available, you need to create symbolic links to qv
and to the gx script files:

% rm /usr/local/bin/qv

%rm-i /usr/local/bin/qgx*

%In -s quantifyhome/qv /usr/local/bin
%In -s quantifyhonme/ gx* /usr/local/bin

For more information on the gx script, see the Quantify online help.

Making Rational PureCoverage Scripts Available

To make Rational PureCoverage scripts available, you need to create symbolic links to
the pc_* script files:

%rm-i /usr/local/bin/pc_*
% In -s purecovhone/scripts/pc_* /usr/local/bin

For more information on the pc_* scripts, see the PureCoverage online help.

Making Debugger Scripts Available on HP-UX

On HP-UX, Rational Purify, PureCoverage, and Quantify include three scripts that
enable you to start instrumented programs under a debugger. You need to create
symbolic links to these scripts. For example, for Purify:

% rm/usr/local/bin/purify_dde
% rm/usr/local/bin/purify_xdb
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% rm/usr/local/bin/purify_softdebug

%In -s <purifyhonme>/purify_dde /usr/local/bin

%Iln -s <purifyhome>/purify_xdb /usr/local/bin

%In -s <purifyhonme>/purify_softdebug /usr/local/bin

For Rational PureCoverage and Quantify, create the same symbolic links, substituting
purecov or quantify for purify.

The installation is now complete.

Configuring Rational Rose for UNIX

This section details Rational Rose for UNIX configuration, performed after
installation. You must complete these steps before using Rational Rose.

The following topics are covered in this section:
= Rose for UNIX Configuration Files on page 120
Rose.ini File Replaced By rose.reg on page 120
Configuring Your Printer on page 121
= Using Rose for UNIX on page 122
= Initial Runtime Instructions When Upgrading on page 122
= Installing and Using Converted Fonts Provided in this Release on page 122

Configuring the Rose/ClearCase Integration on page 123

Rose for UNIX Configuration Files

Executing rational_dir/releases/DevelopmentStudioUNIX.2002.05.00/platform/bin/rose
(where platform is hppa_hpux or sun4_solaris2) will run the Rose configuration file
config.sh before bringing up Rose. The configuration file sets environment
information such as the Rose home directory and location of the license file.

Rose.ini File Replaced By rose.reg

Any settings previously in the Rose.ini file are now in the registry file, rose.reg. This
new registry file is located in the rational_dir/releases/rose.2002.05.00/registry directory
of the release. The settings in this file are entered in your registry, after running
rose_cleanup and then rose. Any changes made to the release rose.reg file will apply to
all users running rose. If you wish to make changes specific for your environment, a
rose.reg.template file is available in rational_dir/releases/rose.2002.05.00/registry. Copy this
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file to your $HOME directory and name it $USER.reg. Edit this file with the settings
you prefer, run rose_cleanup and then rose. Rose will automatically register your
$HOME/$USER.reg file and your settings will be available in your Rose session.

Configuring Your Printer

Perform the following steps to configure your printer for use with Rose.

You may print to your default printer by selecting the appropriate print options
within Rose. Rose will print to the printer defined in the PRINTER environment
variable.

You may install a default printer, or redefine or add ports by editing your
$HOME/windows/win.ini file as described. Any changes made to your
$HOME/windows/win.ini will apply to your personal configuration.

You may also edit the release win.ini file
(rational_dir/releases/rose.2002.05.00/mw/win.ini). In this case, the same change will
apply to any new user who runs the release.

o

Specify the default printer under the [windows] section, using the following
syntax:

devi ce=out put devi cenane, PSCRI PT, portconnecti on:

The keyword PSCRIPT (PostScript) is used in place of the devicedriver.
Rose for UNIX supports PostScript printing only.

Specify the UNIX command in the [ports] section. The [ports] section lists
available communication and printer ports. The LPTnh keywords are mapped to
UNIX commands. In the following example, LPT1 and LPT2 are mapped to the
print command Ip. The print job output is sent to a file. The output file is then
sent to the printer. The term “%s” tells the system to substitute the name of the
PostScript intermediate output file. The term -dps1700 in the example directs
the print job to a UNIX printer named ps1700.

LPTL:=Ip -c "%"
LPT2:=lp -c -dps1700 "9%s"

Note: When using Ip, the -c option should always be used.

Rose does not use the [PrinterPorts] section. Modifying this section will have
no effect.
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o The [devices] section lists the active and inactive output devices that can be
accessed by device driver PSCRIPT and specifies ports to which these devices
are connected. In the following example, Default Postscript
Printer=PSCRIPT,LPT1.: specifies that the printer is connected to the PSCRIPT
queue that is connected to LPT1:

[ devi ces]

Def aul t Postscript Printer=PSCRI PT, LPT1:

Post script Printer QVS=PSCRI PT, LPT2:

The devices listed in this section appear in the File > Print dialog, under Name.
In this dialog you may select the printer you wish to use.

Using Rose for UNIX

Use the following commands to start Rational Rose products:

Product Command
Rose for UNIX rose
Analyzer analyzer
Rose Model Integrator modelint

These commands are shell scripts contained in the
rational_dir/releases/DevelopmentStudioUNIX.2002.05.00/platform/bin directory (where
platform is hppa_hpux or sun4_solaris2)

Initial Runtime Instructions When Upgrading

Any user running an earlier version of Rose, should run
rational_dir/releases/DevelopmentStudioUNIX.2002.05.00/platform/bin/rose_cleanup (where
platform is hppa_hpux or sun4_solaris2).

It is only necessary to perform this step once — before running Rose.

To run Rose, see Using Rose for UNIX on page 122.

Installing and Using Converted Fonts Provided in this Release

Rose includes fonts that are compatible and may be used on both personal computers
and UNIX displays. For more information on using these fonts, please see the Rational
Rose Release Notes.
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Configuring the Rose/ClearCase Integration

It may be necessary to reconfigure an earlier Rose/ClearCase integration set up.
Before using the Rose/ClearCase integration with this release, review the following
file (located in this release):

rational_dir/releases/rose.2002.05.00/addins/clearcase/README

Configuring Rational SoDA

This section describes Rational SODA configuration options available during
installation, and for reconfiguration purposes after installation.

Note: If you are using an earlier release of SODA, read about upgrading from previous
releases in the Rational SODA Release Notes before installation.

Installation Requirements for Rational SoDA

Note: FrameMaker + SGML is no longer shipped with SoDA. It must now be licensed
and installed independently. Rational SODA 2002.05.00 supports FrameMaker+SGML
5.5 and 6.0.

If you have previously installed version 3.0.1, 3.0.3, or 3.1.0 of Rational SODA, you can
choose to use the installation of FrameMaker+SGML bundled with that release. To do
this, copy the entire SODA directory to a new location and uninstall the previous
version of Rational Suite. This way, you do not accidentally remove the previous
version of Rational SODA when you uninstall the Suite.

Note: To optimize disk space by removing the SODA components and keeping only
the FrameMaker+SGML components, refer to Technical Application Note 17972 at the
following location: www.rational.com/support/.

SoDA Components

During installation, you will have the option of choosing which SoDA components to
load. The following describes these components.

Required Components
You must load the two components that are required for all installations:

= SoDA Common Component, containing document templates, X resources,
apiclients file updates, and so on

= SoDA Components for platform, the platform-specific executables
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The SoDA installation process is hot optimized for heterogeneous networks (more
than one UNIX platform). If you need to install more than one version of SODA,
contact Rational Technical Support.

Optional Components

There are additional components that you may need to load, depending on the needs
of your project:

Apex Domain for platform, containing source-domain definitions, executables,
and so on for integrating SODA and Rational Apex. You must load it to use SODA
with Apex.

TestMate Domain for platform, containing source-domain definitions,
executables, and so on for integrating SODA and TestMate. You must load it to use
SoDA with TestMate.

Rose Domain for platform, containing source-domain definitions, executables,
and so on for integrating SODA and Rational Rose. You must load it to use SODA
with Rose.

RoseRT Domain for platform, containing source-domain definitions, executables,
and so on for integrating SODA and Rational RoseRT. You must load it to use
SoDA with Rose RealTime.

Ghostscript postscript interpreter for platform, this is public domain software for
processing PostScript images. You may install this component for improving the
appearance of diagrams generated by the Rose domain. Ghostscript is provided
without warranty or support. Use of Ghostscript is subject to the GNU General
Public License. See the Rational SODA Release Notes for more information.

ClearCase Domain for platform, containing source-domain definitions,
executables, and so on for integrating SODA and Rational ClearCase. You must
load it to use SODA with ClearCase.

ClearQuest Domain for platform, containing source-domain definitions,
executables, and so on for integrating SODA and Rational ClearQuest. You must
load it to use SoDA with ClearQuest.

SoDA Training, a platform-independent tar file. Load it only if you have SoDA
users who are planning to attend Rational’s SODA training class. (Further
instructions on completing the installation of the SODA Training component are
provided with the training material.)

SoDA Demo, a platform-independent component for demonstrating SODA
features. It is intended primarily for use by Rational personnel. Unless requested
by your Rational representative, you do not need to load this component.
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SoDA Control Options

If you have Rational Apex installed, you will be prompted during installation to
provide a control type for use during checkin of a FrameMaker+SGML file. These
options are only applicable if you are loading the Apex Domain component. Here are
the two options for SODA control:

Storage in binary format or MIF (Frame’s Maker Interchange Format) upon
checkin

Document locking (Frame’s View Only format) upon checkin and document
unlocking upon checkout

Storage Formats

You can specify the way in which versions of controlled documents are stored in the
CMVC database. The two choices are:

Binary format, which is the normal format of FrameMaker+SGML documents.
This format is more compact and requires less time for FrameMaker+SGML to
save and open.

However, CMVC does not store versions of binary files efficiently. Each version is
stored as a full copy of the current binary file. Over time, as many new versions are
checked in, the CMVC database will grow very large even if each version contains
only minor changes.

MIF, which is an ASCII representation that fully describes the contents of
FrameMaker+SGML documents. MIF can be several times larger than the
equivalent binary format and requires more time for FrameMaker+SGML to save
and open (because FrameMaker+SGML must convert the MIF from/to binary).

However, CMVC stores versions of ASCII text files efficiently. Only one version is
stored as a full copy of the original file. All other versions are stored as
differentials. Over time, as many new versions are checked in, the CMVC database
does not grow too large if most versions contain only minor changes.

Because MIF files are often quite large, calculating the differences between
versions can take some time, thereby slowing the checkin.

A Binary Example

For example, a 10 KB document is controlled in binary format, and its initial version
takes up 10 KB in the CMVC database.
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The document is checked out, additions are made to it, and its size is now 15 KB. The
document is checked in, and its two versions use 25 KB (10 KB + 15 KB) in the CMVC
database.

The document is checked out again, minor changes are made to it, and its size remains
15 KB. It is checked in again, and its three versions use 40 KB (25 KB + 15 KB) in the
CMVC database.

A MIF Example

The same 10 KB document is controlled in MIF, and its initial version uses 30 KB in
the CMVC database. (For this document, the MIF was three times larger than the
equivalent binary format.)

The document is checked out, additions are made to it, and its size (in binary format)
is now 15 KB. The document is checked in, and its two versions use 36 KB (30 KB +
6 KB in differences) in the CMVC database.

The document is checked out again, minor changes are made to it, and its size (in
binary format) remains 15 KB. It is checked in again, and its three versions use 37 KB
(36 KB + 1 KB in differences) in the CMVC database.

Document Locking

When documents are controlled and checked in, their UNIX file permissions are set to
be read-only (r--r--r--). However, there is no easy way to tell if a document is read-only
from within FrameMaker+SGML.

You can tell SODA to lock documents when they are checked in and unlock them
when they are checked out. When a document is locked (in FrameMaker+SGML View
Only format), it is apparent in FrameMaker+SGML that the document is not
editable—you cannot select text or type in the document until it is checked out and
unlocked.

Using SoDA with Rational Rose

During installation you may be asked if you want to use SoDA with Rational Rose. If
you answer yes, you must also provide the location of your Rose installation. The
install process will automatically configure SODA to use the version of Rational Rose
you have specified.

See the release notes for further information about using SODA with Rational Rose.
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Using SoDA with Rational Rose RealTime

During installation you may be asked if you want to use SODA with Rational RoseRT.
If you answer yes, you must also provide the location of your RoseRT installation. The
install process will automatically configure SODA to use your RoseRT installation.

See the release notes for further information about using SODA with RoseRT.

Using SoDA with Rational Apex

If you are installing SoDA for use with Rational Apex, and if you would like apexinit
to automatically start SODA for all Apex users, use your preferred text editor to adjust
the soda.start script in the rational_dir/releases/soda.2002.05.00/share/bin directory.
Uncomment the appropriate line as indicated by the instructions in the file.

Normally, it is better not to make this adjustment unless all Apex users will also be
regular SoDA users. Usually, only some Apex users are regular SODA users.

See the release notes for further information about using SODA with Apex.

Using SoDA with Rational ClearQuest

During installation you may be asked if you want to use SoDA with Rational
ClearQuest for UNIX. If you answer yes, you must also provide the location of your
ClearQuest installation. The install process will automatically configure SODA to use
the version of Rational ClearQuest you have specified.

See the release notes for further information about using SoDA with ClearQuest.

Reconfiguring SoDA

Sometimes it is necessary to reconfigure SoDA after installation, for example to
specify a new Rose installation, or if the SODA installation is moved. Configuration of
SoDA is performed during the post_install phase of rs_install. You may run rs_install
using the post_install alias to reconfigure SoDA.

Licensing may also be reconfigured after install by using the license_setup and
license_check tools, described earlier in this manual.

Using SoDA

After you have completed the SoDA installation, you may start SODA by running the
sodacommand. For further information, see the instructions for SODA users in the
“Getting Started” chapter of Using SoDA with Frame.
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Troubleshooting

Use the information in this chapter if you run into problems installing Rational Suite.
The following areas are covered in this chapter:

Troubleshooting the Installation of Rational Suite (UNIX Components) on page 129
Troubleshooting the Installation of Rational Suite (Windows Components) on page 134

Contact Rational Technical Support if you are unable to resolve your problems or if
you have questions regarding the installation, use, or maintenance of this Rational
Software product.

Troubleshooting the Installation of Rational Suite (UNIX
Components)

Error messages are shown in bold italics in this section.

General Problems

Display problems

If you are having problems with the display showing strange characters on your
screen and your screen does not clear for each new menu, you may have your TERM
environment variable set incorrectly. Try setting it to something else like xterm, vt100
or ansi. To prevent the program from using escape sequences to do underlining, run
the programs with the -no_underlining (alias -nu) option. This will prevent the
commands from using escape sequences.

Problems uninstalling

If uninstalling something fails, it may be that you are not the original installer. Log in
as the person who installed the product and rerun the uninstall script as that person.
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Cannot create directories

If you have problems creating directories, it may be that you do not have the correct
permissions. Check your login name and the groups you belong to using the UNIX id
command. Check the directory permissions of the directory where you are trying to
create a directory. You must have read (r), write (w), and execute (x) permissions for
you or the groups you are in.

Permission problems

If you have permission problems with the tar command, it may be that you are trying
to install on top of an already existing product. In most cases, this type of error can be
ignored.

Disk space unavailable

If you run out of disk space while installing products, you cannot ignore this problem.
The best thing to do is uninstall the Suite and reinstall it in a place where you have
sufficient space to do the installation. Disk space requirements are summarized in
Rational Suite (UNIX Components) Installation Requirements on page 29. The
approximate amount of disk space you need to install the Suite is also provided in the
Product Customization Menu when you run the rs_install command.

Could not find rs_install data.

Check that you have correctly mounted the CD-ROM. Refer to Accessing the CD-ROM
Drive on page 145. Make sure that you are running the installation commands from
the CD-ROM directory. There must be an extras directory in the same location. The
command looks for the installation data in there. If you have mounted the /cdrom
directory from another system, make sure the directory has been properly exported —
it needs to be listed in the filesystem table for exported file systems. This file is
operating-system dependent.

FAIL: Could not install fileO:

This means that the installation was trying to untar this file. In doing so, it expected it
to create a directory structure that looks something like releases/product.ver/install. It
could be that the tar command failed due to lack of disk space, or you do not have
permissions to read the file. Check to see if you can untar the file that is shown by
doing a tar -tf <file0> where <file0> is the full path to file0.
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FAIL: Could not find a file to install from here:

This means that the install could not find a tar file in the listed directory. It could be
that you are trying to install a Solaris CD-ROM on a non-Solaris system or an HP-UX
CD-ROM on a non-HP-UX system.

Licensing Problems

There is a problem with one license key.

or

There are problems with <N> license keys.

This means that the license keys in the license file do not match and are inconsistent
with the text of the license. The licenses consist of several parameters and a 12-digit
hexadecimal key that was created using these parameters. The parameters are in
ASCII text but they cannot be changed or it will invalidate the license. The parameters
used to create the license are the server host ID, license name, vendor daemon name,
expiration date, number of users (quantity), VENDOR_STRING, OVERDRAFT,
SUPERSEDE, DUP_GROUP, and NOTICE.

It appears that DevelopmentStudio for UNIX <version_number> is not licensed.
This means that there is a problem with the license server. It could be that:

1 The license server was never started.

2 The license server failed to start. This happens when the license keys are
inconsistent.

3 There is already a license server running but it is not using the Rational Suite
DevelopmentStudio license file.

Check the license server log file which is kept in /rational_dir/config/server-name.log.
Users of DevelopmentStudioUNIX: Cannot get users of

DevelopmentStudioUNIX: No such feature exists
(-5,222)

This could mean that multiple Rational servers are running, or a stale lock file was not
cleaned up. This error could result from either:

1 Another copy of Imgrd is running.

2 A prior Imgrd was Killed with kill -9 which would leave the vendor daemon
running.
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To correct this, kill the Imgrd and rational processes and remove the Rational lock
file:

a Use the ps command or equivalent to find the process IDs:

ps -ax | egrep “Ingrd|rational”
b Kill those processes:

kill Process-1Dof-1mgrd Process-I1D of-rational
¢ Remove the lockrational file which can be found at either:

lusritmp/lockrational
or
/tmp/lockrational

Run /rational _dir/config/start_| ngrd_on_nachi ne

You do not have remote access to <license-server-name> from
<local-host-name>, so it cannot be set up as a license server...

It may be that the license server is not the same system on which you are installing.
You must have remote shell access (rsh or remsh) to the license server system.

Host <license-server-name> is running Solaris.

Host <local-host-name> is running HP-UX.

They do not match so <license-server-name> cannot be used as alicense
server.

It may be that the license server is not the same system on which you are installing. If
so, it must run the same operating system that the product you are installing requires.
Host, <license-server-name> does not have access.

If the license server is not the same system on which you are installing, it must have

access to the rational_dir directory where Rational products have been installed.

Cannot set <license-server-name’s> host ID
with this command:
rational_dir/base/cots/flexIm.7.0f/Imhostid

The Imhostid command failed. Check to see if the Imhostid command shown will run
on your local host. If so, enter the host id number in the License Server Host ID Menu
(choice number 2).
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Cannot access rational_dir/base/cots/flexIm.7.0f/Imhostid on
<license-server-name>.

There was a problem accessing the rational_dir directory or the Imhostid command
was not installed from the CD-ROM.

Host ID <nnn> not valid. Less than 4 digits.

This means that the host ID number will not work. Check again using the Imhostid to
see what the host ID is. It should be at least four or more hexadecimal digits.

Port number <pn>is in use in /etc/services.

or

Port number <pn>is in use under NIS services.

If you entered a port number and it appears that the number is in use in your
letc/services file or under NIS services, you may have a problem with licensing.
Rational products use FLEXIm which uses TCP/IP sockets to communicate with a
license server using a specific port number. This port number is specified in the
license file on the SERVER line. The license server will not be able to open a socket on
a port that is already in use. Rational recommends that you use the default port
number, 27000.

Checked the import file and could not find an INCREMENT line for:

License Feature Description
DevelopmentStudioUNIX Suite DevelopmentStudio for UNIX (UNIX
Components)

DevelopmentStudioUNIXWeb Rational Suite DevelopmentStudio for UNIX (Windows
Components)

There does not appear to be any license information to import for Rational
DevelopmentStudio for UNIX.

This means that the import file you specified contains INCREMENT lines but none of
them match the two that are expected. Make sure that the file you import contains one
or both of these licenses.
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Users of DevelopmentStudioUNIX: (Total of 1 license available)
Users of DevelopmentStudioUNIXWeb: NOT LICENSED

1 of the 2 license components is not being served.
This may be okay, since 1 license is being served.

This means that you only have a license to use Rational Suite DevelopmentStudio
(UNIX Components). If you are not using the unlicensed product, no action is
necessary. If you plan to use the Windows Components, request a Rational Suite
DevelopmentStudio (Windows Components) or a Rational Suite DevelopmentStudio
RealTime (Windows Components) license from AccountLink.

Error message: ulimit: bad ulimit

If you see this message when you run start_Imgrd, remove the ulimit command from
the script.

Troubleshooting the Installation of Rational Suite (Windows
Components)

General Problems

If you have problems installing the Web Interface components of Rational Suite, try
the following suggestions before you call Rational Technical Support:

Be sure to stop all applications before you begin the installation.

Turn off all virus protection software. These programs often run in the background
and interfere with the installation and file decompression process.

= Turn off any user interface managers or desktop environments that run on top of
Microsoft Windows.

= Disable video features such as virtual screens or screen switching.

Change to a standard mouse driver, or disable special mouse features that perform
tasks such as leaving pointer trails or Support Information
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Licensing Problems

The Imtools application is available on Windows and is designed to help diagnose
licensing issues. Rational installs this application with all products in the
rational_dir\common directory. If the license server is installed, click Start > Rational
License Server > License Tools. For more information about using this diagnostic tool,
see the FLEXIm User Guide. You can access this guide online by typing rsdsu_help.
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Rational Rose - Operating
System Runtime and/or
Patch Requirements

The requirements below are in relation to the following platforms (operating system
versions):

HP-UX 10.20 (ACE) and 11.00
Sun Solaris 2.6, 2.7 (Solaris 7), and 2.8 (Solaris 8)

Note: If you are currently using Rose and your installed operating system patches are
currently meeting your needs, we strongly recommend that you not change your
installed patches. The following patches are recommended for new customers and
customers experiencing problems. If you upgrade your patches, we recommend that
you use the following patch versions. While we encourage you to contact the
appropriate vendor to determine if a patch has been superseded, we cannot guarantee
release compatibility with a patch version we have not yet tested. For information
regarding the latest patch versions tested or required with this release, visit the
Rational web site at http://www.rational.com/support.

Contact Rational Technical Support if you encounter any compatibility difficulties
after installing a patch which supersedes the following patches.

HP-UX 10.20 and 11.00 Patch Requirements and Descriptions

Table 12 summarizes the patch requirements for HP-UX 10.20 and 11.00.

Table 12 HP-UX 10.20 and 11.00 Patch Requirements for Rose

Runtime - Operating System

Patches Description Reason for Patch Versions and Notes

PHCO_19434 S700_800 10.20 csh(1) [ Fixes crash of csh exit of | HP-UX 10.20 (ACE)
cumulative patch MainWin

PHSS_21461 S700_800 10.20 Xserver | Fixes Xserver crash with | HP-UX 10.20 (ACE)
cumulative patch multiple rectangle

PHSS_17872 HP aC++ runtime Runtime for compiler HP-UX 10.20 (ACE)
libraries (aCC A.01.21) | A.01.21

137



Table 12 HP-UX 10.20 and 11.00 Patch Requirements for Rose

PHSS 19739 S700_800 10.20 HP Problem with threads HP-UX 10.20 (ACE)
DCE 9000 1.5
cumulative patch

PHSS_17225 S700-800 10X did.sl(5) | Runtime requirement HP-UX 10.20 (ACE)
cumulative patch

PHSS_ 173271 X/Moatif 2.1 Dev Kit Runtime requirement HP-UX 11.00
Mar99 Periodic Patch

PHSS_19866 Id(1) and linker tools | Resolve dld.sl error when | HP-UX 11.00
cumulative patch using CORBA & Java
Operation Specification
Window:

{usr/lib/dld.sl:
Unresolved symbol:
(libot.sl (unknown))

PHSS 16587 s700 800 11.X Runtime requirement HP-UX 11.00

HP aC++ (aCC
A.03.13) runtime
libraries

1 Rose requires HP-UX OS Patch PHSS_17327 (X/Motif 2.1 Dev Kit Mar99 Periodic Patch). This Patch
requires PHSS_17326 (X/Motif 2.1 Runtime Mar99 Periodic Patch). PHSS_17326 has been superseded by
HP-UX OS Patch PHSS_23823

It is important to use PHSS 23823 as Rose for UNIX will not start (display) if an
earlier version of this patch is installed (that is, PHSS 21493).

If it is necessary to have a Motif Xlib runtime patch prior to PHSS 23823 and you
encounter this issue, refer to the following instructions to workaround this problem:

1 Make sure your Rose process is no longer running. (Use ps to determine if the
process is running, and “kill -TERM [pid]” if it is necessary to kill the process.)

2 Asthe owner of these files, enter the following commands:

cd rational _dir/releases/rose.|.J. K install/patches/hppa_hpux/hpll

cp libX11.3 rational _dir/rel eases/rose.|.J. K hppa_hpux/hpll/lib/.

chrmod 555
rational _dir/rel eases/rose.|.J. K hppa_hpux/ hpl1/1ib/libX11. 3.

3 Runrose_cleanup.

4 Runrose.
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The HP-UX patches are available at:

http://us-support.external.hp.com (US, Canada, Asia-Pacific and Latin-America)

http://europe-support.external.hp.com (Europe)

= ftp://us-ffs.external.hp.com (“anonymous” FTP)

Solaris Patch Requirements and Descriptions

Note: Some patches are required on the server (the computer from which Rose is
launched) and the client (the computer that is used to display Rose), and some are
required only on the client. In some cases, the server and client are the same computer,
but often several users login to one server (to run the application) and have their own
displays which serve as their client. The following Sun Solaris patch
recommendations are specific to Sun Solaris servers and clients. Table 13 summarizes
the server and client patches. Table 14 summarizes the client patches.

Table 13  Solaris Server and Client Patches for Rose
Server and
Cllen_t Description Reason for Patch Opel_'atlng System
Runtime Version
Patches
105181-16 | Kernel update | Fixes kernel thread problems Solaris 2.6
patch
105591-06 | Shared library | Shared library fix Solaris 2.6
patch for C++
105633-32 | Xsun patch To fix defects in XinitThreads and Solaris 2.6
_Xflushint, that is, defect fixes for
multi-threaded applications under X.
106040-12 | X input and Fixes input/output problem Solaris 2.6
output method
patch
106327-05 | Shared library | Shared library fix Solaris 7
patch for C++
108376-03 | Xsun patch To fix defects in XinitThreads and Solaris 7
_Xflushint, that is, defect fixes for
multi-threaded applications under X.
108434-01 | Shared library | Shared library fix Solaris 8
patch for C++

Solaris Patch Requirements and Descriptions 139




Table 14

Solaris Client Patches for Rose

Client Operating System
(Display) [ Description Reason for Patch Version & Graphic
Patches Card
105361-10 | VIS/XIL Provides the imaging and video Supplemental for
Graphics Patch | foundation for Solaris Creator or Elite
graphics card on
Solaris 2.6
106147-03 | VIS/XIL Provides the imaging and video For Creator or Elite
Graphics Patch | foundation for Solaris graphics card on
Solaris 7
105362-20 | M64 Graphics Required for PGX (M64 Graphics card) | For PGX (M64
Patch PCl-based Ultra 5, 10, and 60: Graphics card) on
» To fix gui hanging problems Solaris 2.6
= To fix paint problems (black/white
regions appear in menus, dialog
boxes, toolbars, and so on)
106146-10 | M64 Graphics | See “Reason for Patch” under patch For PGX (M64
Patch 105362-20 Graphics card) on
Solaris 7
105360-28 | FFB Graphics Supplemental patch for VIS/XIL For Creator
Patch graphics patch: Graphics Card on
= To fix gui hanging problems Solaris 2.6
= To fix paint problems (black/white
regions appear in menus, dialog
boxes, toolbars, and so on)
106145-12 | FFB Graphics See “Reason for Patch” under patch For Creator
Patch 105360-28 Graphics Card on
Solaris 7
105363-24 | AFB Graphics | Supplemental patch for VIS/XIL For Elite3D
Patch graphics patch for Elite 3D frame buffer: | Graphics Card
= To fix gui hanging problems Solaris 2.6
= To fix paint problems (black/white
regions appear in menus, dialog
boxes, toolbars, and so on)
106144-12 | AFB Graphics | See “Reason for Patch” under patch For Elite3D
Patch 105363-24 Graphics Card
Solaris 7
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Table 14

Solaris Client Patches for Rose (continued)

Client Operating System
(Display) Description Reason for Patch Version & Graphic
Patches Card
106391-01 | TCX Graphics | To fix GUI hanging, and to fix paint For TCX Graphics
Patch problems (black/white regions appear in | Card on Solaris 2.6
menus, dialog boxes, toolbars, and so
on)
107851-01 | PGX322.1 Recommended for GFX graphics card For GFX Graphics
Graphics Patch Card on Solaris 2.6,
and 7 if
“VERSION” line
from pkginfo -I
TSIgfixOW
indicates 2.1,
otherwise refer to
following patches
107715-04 | PGX32 Graphics | Recommended for GFX graphics card For GFX Graphics
Patch card on Solaris 2.6
if 107851-01 does
not apply
107716-04 | PGX32 Graphics | Recommended for GFX graphics card For GFX Graphics
Patch card on Solaris 7 if
107851-03 does not
apply
105492-02 | cgsix driver For issue related to GX frame buffer For cgsix Graphics
patch Card on Solaris 2.6

The Solaris patches are available at:

= http://sunsolve.sun.com/private-cgi/show.pl?target=patches/patch-access

The Sun Solaris patches may not be available publicly.

The following may be necessary to obtain some of the Solaris patches listed above:

= You must have maintenance support with Sun; or

= The system must be under warranty; or

You must be willing to pay for a patch to receive it.

Solaris Patch Requirements and Descriptions
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Detecting a Graphics Card
How to detect a graphics card on a Sun Solaris computer:

% I|s /dev/fbs/*
/dev/fbs/m640 — PGX graphics card
/dev/fbs/afb* — Elite3D graphics card
/dev/fbs/ffb* — Creator/Creator3D graphics card
/dev/fbs/cgsix* — GX graphics card
/dev/fbs/leo* — ZX graphics card
/dev/fbs/sx* — SX graphics card
/dev/fbs/tcx* - TCX graphics card
/dev/fbs/gfx* - GFX graphics card

Errors Encountered if Correct Sun Solaris Runtime Not Installed

A user will encounter the following error if the appropriate Sun Solaris runtime
patches are not installed:

| d.so.1: exe_name: fatal: |ibCrun.so.1l: open failed: No such file or
directory
Displaying on Ultrabook, Using PGX Graphics Card

A CDE crash may occur when displaying Rose for UNIX/Linux on a Ultrabook using
a PGX Graphics Card, if Sun Solaris patch 105362-26 is installed.

If using a PGX Graphics Card, we recommend that Sun Solaris patch 105362-20 be
installed as this is the latest version tested and determined to be compatible with this
release.

If you encounter the CDE crash, uninstall patch 105362-26 and if possible install
105362-20. If Sun Solaris patch 105362-20 is not installed, the following may occur:

GUI hanging issues

= Paint problems (that is, black/white regions may appear in menus, dialog boxes,
toolbars, and so on)

If you uninstall patch 105362-26 and encounter any of the issues described above, or if
patch 105362-20 is not available, contact Rational Technical Support .
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Support for the PGX32 Add-on Board

If your client computer has the PGX32 add-on board (based on the Permedia 2 chip),
you need to install the drivers and patches for this card. You cannot see the device in
the /dev/fbs directory unless the drivers are installed.

Contact Rational Technical Support if you require information in relation to the Sun
Solaris drivers or patches for the PGX32 add-on board.
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Accessing the CD-ROM
Drive

This section provides instructions for mounting and unmounting a CD-ROM drive in
the UNIX environment.

Mounting the CD-ROM Drive

As root, make a directory (if one does not already exist) to be the mount point for the
CD-ROM drive. The following examples for each platform use the directory /cdrom.
Make sure you know the device name of the CD-ROM drive. If you do not know the
device name for the CD-ROM drive, consult your system administrator. Mounting
commands for different operating systems are as follows:

Sparc/Solaris with Volume Management

Solaris 2.x with volume management mounts to the /cdrom directory. This happens
automatically when you load the CD-ROM drive. You have volume management if
the vold daemon is running on the system.

Sparc/Solaris (Solaris 2.x) without Volume Management

# nkdir /cdrom
# nmount -r -F hsfs /dev/dsk/cOt 6d0sO /cdrom

HP-UX 10.x, 11.0, 11.11 (11.i)
# nkdir /cdrom

# mount -r -F cdfs /dev/dsk/cOt2d0O /cdrom
Unmounting the CD-ROM Drive
For CD-ROM installs, unmount the CD-ROM drive with the following commands.

For Solaris with volume management (vold is running):
% ej ect cd

All others must unmount the CD as root.
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% su
# unount /cdrom

Note: You cannot eject the CD if you are at the directory /cdrom or /cdrom/cdrom0. If
you get a “Device busy” error, change your directory location to a location other than
the CD-ROM and repeat the above commands.

146 Chapter - Accessing the CD-ROM Drive



Glossary

AccountLink. Rational’s Web-based license management tool. Customers can use this tool to request
and return licenses to their Rational accounts.

ANY-HOST. A license key issued for ANY-HOST will run on any system, and is not tied to the
customer's system ID.

Emergency Key. A temporary key that lets a customer use Rational software for a fixed period of time if
they cannot use their own license for some reason. The duration of the Emergency Key is five days.
Emergency Keys can be node-locked or floating. Emergency Keys are distributed by the Licensing
Support Group and run on any host.

Evaluation Key. A temporary key that lets a customer use and evaluate Rational software for a fixed
period of time. Rational Software determines the duration of the Evaluation Key. Evaluation Keys can be
node-locked or floating. Evaluation Keys are distributed by the Sales team and run on any host.

Floating License. A license type that links products to a license server system. Client systems obtain
licenses from the license server when they need to run a copy of Rational software. Multiple clients can
share the pool of floating licenses; one license is granted per client per product. Floating licenses on
license servers are typically administered by system administrators.

Key Type. Node-locked and floating licenses can be enforced by different types of license keys. The
types of license keys are Startup and Permanent. Evaluation and Emergency keys are variations of
Startup keys, and Term License Agreements (TLAS) are a variation of Permanent keys. Each type of key
has different business rules and policies.

License. A legal right to use a product. A customer receives a license when they purchase the product.
However, they need a license key to actually associate the product and the system on which it is running
with a license.

License Key. Generic term used in this document to describe keys that enable licenses on a customer
system. The types of license keys are: permanent, temporary, evaluation, emergency, and Term License
Agreement (TLA).

License Key Administrator. A Windows program written by Rational Software, which provides a
customer interface to Rational's Licensing system. Similar functionality exists with a subset of the
rs_install command, called license_setup. Starting with the release of Rational Suite 1.0 and associated
point products, the License Key Administrator or license_setup command is installed whenever a
Rational software product is installed. For hosting floating licenses on Windows, the License Key
Administrator is installed when the Globetrotter FLEXIm server is installed on a Windows License
Server system.

License Key Code. An encrypted code used to enforce a license agreement.

License Type. The valid types of licenses are node-locked licenses and floating licenses. See also Key
Type.

Node-Locked License. A type of license that links a product to a system. Typically, one node-locked
license is issued per software copy.
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Permanent Key. A license that lets customers run Rational products indefinitely. Permanent Keys can be
node-locked or floating. Node-locked Permanent Keys are installed on a client system. Floating
Permanent Keys are installed on a license server.

Note: A Term License Agreement, a variation of a permanent key, does have an expiration date. See Term
License Agreement.

Permanent Key Code. The encrypted code that lets a customer run a particular Rational product using a
Permanent Key.

Rational FLEXIm Server. Software license manager for Windows, UNIX, Java, and VMS.

Temporary Key. A short-term license key that lets a customer run Rational software products.
Temporary licenses are not keyed to a specific system. Temporary Keys can be node-locked or floating.
Node-locked Temporary Keys are installed on a client system. Floating Temporary Keys are installed on
a license server.

Temporary Key Code. The encrypted code that lets a customer run a particular Rational product using a
Temporary Key.

Temporary License Key Certificate. A piece of paper or an electronic file that contains information a
customer needs to begin using Rational software with a license. The temporary License Key Certificate is
shipped to the customer with the software installation media.

Term License Agreements (TLAS). Variation of a Permanent Key. TLASs are issued to a site to let their
employees use Rational software for a negotiated period of time. TLASs are issued by Rational Sales and
have an expiration date.
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